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1 Overview and AE Applications

1.1  Overview of ASCO-DAQ?2

Acoustic Emission (AE) testing is a powerful method for examining the behavior of materials deforming under
load. Materials emit sound when they are stressed. The ASCO-DAQ2 AE-instrument listens to these sounds
which can be caused by crack growth, phase transitions, leakage, friction, yielding, fiber-breakage,
debonding, corrosion, wear, capacitive (or partial) discharge, cavitation, impact, etc and makes sound levels
visible.

Everyone is familiar with AE as heard from wood cracking or glass breaking; however, AE equipment as the
ASCO-DAQ?2 can monitor many more useful non-audible emission phenomena. The ASCO-DAQ2
possesses the ability to detect all these AE sources with high sensitivity using state-of-the-art software tools.
It measures burst — and continuous acoustic emission.

AE activity is detected when a mechanical wave is picked up by an AE sensor. AE-activity is typically
monitored above the audible frequency range (often 100-1000 kHz) with a resonant piezo-electric sensor.
The ASCO-DAQ?2 can work with many Vallen AE sensor types and is available in three different frequency
ranges in the overall range from 90 kHz to 1300 kHz. The sensor is an important part of the measurement
chain since it transforms the mechanical wave into an electrical signal. In contrast to audible AE, the
measured AE-signal can be displayed by use of an oscilloscope or a transient recorder display. Typically,
AE-activity is of burst type and can be characterized as a wave packet (burst) that increases, reaches one or
more peak amplitudes and then decreases. Alternatively, AE-activity can be caused by a continuous signal
without discernible start or end.

The ASCO-DAQ? is an easy to operate and versatile, single-channel Acoustic Emission (AE) system.
ASCO-DAQ? is controlled by software running on any PC/laptop with Windows 10 or Windows 11 operating
system via an USB interface. The main features of the ASCO-DAQ2 are

e Low cost & easy to use

¢ Robust design for industrial applications
e Threshold independent

e For continuous and burst AE

e Can discriminate up to 1000 hits/s

The ASCO-DAQ? is ideal for applications where low cost, small form factor and simplicity is essential. The
main application nowadays it the monitoring of crimping processes (crimping metallic end fittings onto fiber
glass rods in the production of high voltage line insulators).

The ASCO-DAQ?2 consists of two components:

1) an analog signal conditioner (same component as it is used in our product ASCO-P, therefore this
signal conditioner component is named in the following often just “ASCO-P”) which extract from the
high frequency signal of the AE-sensor two slower changing signals, the last peak amplitude of the
signal stretched to 50 ms (ASCO-DAQ2-PH3 0.5 ms) and an average signal level. For details see
section 2.1

2) A data acquisition unit digitizing the two output signals of the signal conditioner and two optional
inputs which can be connected to the ASCO-DAQ2 to measure e.g. the pressure, force, or
temperature.

ASCO-DAQ?2 is available in three variants which are listed in the next chapter.
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ASCO-DAQ2 comes with a 2m USB cable and the ASCO-DAQ?2 software (on USB flash drive) including
sample data files and documentation.

The following additional items are required to operate the ASCO-DAQ?2:
e Computer with Microsoft Windows operating system with USB interface

e Vallen AE sensor with interface cable. It is recommended to use Vallen AE-sensors to ensure that
pyroelectric discharge does not damage the ASCO-DAQ?2. For details of available sensors see
document reference [1].

e Standard power supply (e.g. ASCO-NTE)

Figure 1: Complete ASCO-DAQ2 measurement Figure 2: ASCO-DAQ2 measurement system
system without PC

Figure 1 shows ASCO-DAQ2 connected to the laptop with power supply ASCO-NTE and the small VS700-D
sensor clamped to a banknote. Figure 2 shows the ASCO-DAQ2 with power supply and sensor, only.

1.2 Difference between ASCO-DAQ2 device and spotWave device

The single channel ASCO-DAQ?2 device was released in 2006. The software contains now especially
features to support the quality assurance for serial production of crimping processes in the fabrication of
high-voltage insulators. The ASCO-DAQ2 software is maintained but not developed for additional
applications.

The single channel spotWave device was released in 2022. It is a fully featured AE measurement device
compliant with EN 13554, EN 13477-1 and EN 13477-2. It can be used with the Vallen AE Suite software but
is not compatible with the ASCO-DAQ2 software. The special software features and some hardware features
of the ASCO-DAQ?2 device which support quality control during serial production are not available with the
spotWave device.
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Features ASCO-DAQ2 spotWave
Compliant with EN 13554 No Yes
Compliant with EN 13477 No Yes
No of AE channels 1 1
No of parametric channels 2 0
Internal pulser No Yes (CCT)
Sampling rate 48 kHz multiplexed to 4 2 MHz
channels
Peak stretcher (50 ms) Yes No
Waveform recording No Yes
Frequency range 20-1300 kHz 20-500 Hz
Power supply 28 vDC 5VDC (USB on the Go)
Analog outputs 4 No
Connectivity USB 2.0 USB 3
Crimping Monitoring SW Yes No
PRIDB and TRADB support No Yes
Compliant with Vallen AE Suite SW No Yes

Consequently, the ASCO-DAQ?2 device is mainly used for the application of monitoring crimping processes in
serial production, while the spotWave device can be used in AE testing applications that require only one AE

channel.

For more information about the spotWave device, see our internet page https://www.vallen.de

Please get in touch with the sales team of Vallen Systeme if you need more information about the
differentiation of the different AE-systems (see “Contact” on our internet page).
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2 Description

The ASCO-DAQ?2 consists of an acoustic signal conditioner (ASCO-P module) and an USB-data acquisition
unit (USB-DAQ). Both parts are fitted into a rugged box (splash water resistant, classified IP54) for industrial
applications.

The ASCO-P module converts the peak amplitude of a short AE-burst (us-range) to a voltage pulse. This
output signal is called APK. An additional output, ASL, represents the average of the logarithm of the AE
signal over a certain time window and is an indicator for background noise and the signal strength of a burst.

The USB-DAQ module samples APK and ASL as well as two external measurement parameters (e.g.
pressure and elongation) at a programmable sampling rate. Measurement data is transferred to PC by USB-
bus and stored to file.

The ASCO-DAQ?2 software has a graphical user interface (GUI). Every aspect of data acquisition, monitoring
and data display is controlled easily and conveniently by use of the GUI.

In recording mode, the ASCO-DAQ?2 software allows for a threshold independent data acquisition. The
recording mode can be configured in different ways and enables a single-file, single-trigger measurements
up to a recording mode where measurement data and results are classified and archived automatically for
each measurement separately.

The monitoring feature can be used to classify the measurement based on the classification results of up to
the 4 measurement channels. Classification results are shown online in a colored bar on the screen and
sound actions can be associated to each result. The classification result is also available at certain pins of
the external connector labeled J4.

The diagram can be configured to the needs of the user by use of macros, legend, header and footer. All
measurement results and all classification limits can be displayed. Graphs of measurement results can be
toggled easily via the toolbar. Screenshots of the diagram can be made manually or stored automatically with
predefined dimension and resolution.

2.1  Functional description of the ASCO-P module

The ASCO-P module converts the peak amplitude of a short AE-burst (us-range) to a voltage pulse of
40mV/dB g amplitude. The pulse width (peak stretch time PST) is set to 50 or 0.5ms depending on the
ASCO-Pxy module. This output signal is called APK.

Note on dBxe: The dB scale is a logarithmic expression for a factor or ratio according to the equation:

A[dB] =20- Iog[%)

n

Usually, the maximum amplitude of an AE burst is given in dBag by defining the reference voltage (U;,) as
1pV. Therefore 0 dB e corresponds to 1 pV; 20 dBag to 10 pV, 40 dBag to 100 pV, 60 dBAe to 1mV, etc.

An additional output of the ASCO-P module is called ASL. It represents the average of the logarithm of the
AE signal over a certain time window and is an indicator for background noise and the signal strength of AE
bursts.

APK and ASL are scaled to 25dBe/V. 0dB e corresponds to 14V peak at the AE-sensor output.

The ASCO-P module employs three connectors on the front panel of the ASCO-DAQ2:
e “J1 Analog Out”: male 15pole D; resembles the analog output of the ASCO-P for signal analysis,
e “J2 Sensor”: BNC female; is used for AE sensor connection,

o “J37...15Vpc": Jack 5.5mm; is used to feed-in 12V (100mA) power supply, e.g. from ASCO-NTE.

file: ASCO-DAQ2_UMan_2307.docx 8

Copyright © 2023, Vallen Systeme GmbH



vallen
sysceme

A

Figure 3: image of the front panel of the ASCO-DAQ2. On the left-hand side is the connector J1 located-
Then central connector is a BNC connector for the AE-sensor. The connector on the right-hand side is used
for the power supply.

Different ASCO-DAQ?2 variants are available dedicated to specific applications. They differ only in the
frequency range and the peak stretching time of the built in signal conditioner board (ASCO-P).Each ASCO-
P module derivative is identified by a suffix xy (ASCO-Pxy). Which ASCO-Pxy derivative used within the
delivered ASCO-DAQ2 can be seen from the sticker below the J1 connector.

The following table shows the available ASCO-DAQ?2 variants and sensor configurations for different
applications as recommended by Vallen:

ASCO-DAQ?2 variant | Application Freq.[kHz] PST [ms] Sensor
Peak stretch time (recommended)
ASCO-DAQ2-PN1 |Scratch Testing 90-290 51 VS150-M
ASCO-DAQ2-PH3 | Crimping Monitoring 240-710 51 VS600-A2
ASCO-DAQ2-PH5 | Paper Tensile Testing 90-1300 0,5 VS700-D

Table 1: list of ASCO-DAQ?2 variants and typical applications.

2.1.1 Block diagram of ASCO-P module

Output Filter
Filter Low Pass Output ASL
Module P
Log- Peak
3| Pream 9 Output APK
Sensor P Conv. Stretcher P
(BNC)
I Input Reset
Com- | | puiser L_| Opto Output Optocoupler +
parator coupler I Output Optocoupler -
Input Threshold

Figure 4: block diagram of the ASCO-Pxy module.

The AE signal (delivered by a piezo-electrical AE-sensor) is fed-in over a BNC-connector and amplified by a
low noise preamplifier. A filter module rejects undesired frequency components. The filtered AE-signal is
rectified, and the logarithm is obtained. This logarithmic signal is smoothened by a low pass filter and output
as ASL (average signal level). In parallel a peak-stretcher stretches even short peaks of the logarithmic
signal for a certain amount of time and outputs it as APK (AE peak amplitude). A comparator compares the
logarithmic signal against a threshold fed-in as analog voltage. When the logarithmic signal exceeds the
threshold, a pulse is generated, and is output over an optocoupler at J1 (see below). Depending on the
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application this can trigger e.g., an alarm, or an image record, an event counter, or a more detailed analysis
of the incoming data.

The DAQ2 module is based on the USB- data
acquisition module:

National Instruments USB-6009 OEM.

The USB bus is located at the rear panel
connector J5 (type B female). For connecting
with a PC, the supplied USB cable can be used.

The DAQ2 module features 4 analog input
channels, two of which are reserved for APK and
ASL. The remaining two input channels can be
used for external parametric signals.

In addition, 2 analog output channels and 12
digital input and output channels are available.

All input and output signals are fed through
connector J4 at the rear panel.

2.2  Functional description of the DAQ2 module
:_ __________________________________
! ASCO-DAQ2
1
1
AE-Sensor :: Preamplifier Filter —» Log(Abs(AE))
|
[
Power . ASCO-P Signal Conditioner i
Supply —tbl ]
ASCO-NTE 1 * ;
! Low-Pass Peak- Threshold
! Filter Stretcher r Comparator
i sw3
H L4 v |
i Al1: ASL Al0: APK AOQ: THR
1
1
1
Ext. Stress- 1| . -
Parameter ) Al2: Stress DAQ2 Trigger
1 4-Channnel
= - b Data Acquisition
3 Strain- L 1 al3: Strain Nodule AO1: Spare
arameter |
! !
!
Vi USB 2.0 Dig. /O
[
I ¢_ J
USB 2.0 Data Storage

r
| | Data Display
]
i
1

Figure 5: ASCO-DAQ?2 Block Diagram

PC with Windows XP

Analog input channels (see specification 4.2.3)

Figure 6: image of the ASCO-DAQ2 back panel.
To the left-hand side is connector J4, to the right-
hand side is USB interface

Item Description
Number of available channels 4 (AIO, Al1, AI2, AI3)
Sampling resolution 14 bit

Input range -5to +5V

Channel assignments

AIO = APK; All = ASL (both signhals from ASCO-P module in dBag);

AlI2 and Al3 = external parametric channels (e.g.: elongation, pressure,
temperature etc.)

A parametric conversion (linear conversion) to physical units can be made
by use of the ASCO-DAQ?2 software
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Analog output channels (see specification 4.2.4)

Item Description

Number of available channels 2 (AOOQ, AO1)
Input range -5to +5V

Channel assignments AOQO delivers the threshold signal which can be set by the user within the
ASCO-DAQ?2 software. It is connected to the analog threshold input of the
ASCO-P module. AOO can be used to trigger the optocoupler output (pin 3
and pin 10 of connector J1) if the APK signal (before peak stretcher)
exceeds the defined threshold.

AOL1 is reserved for future usage and currently without function. The
output is available at pin 7 of connector J4.

Digital channels

Item Description

Number of available channels 12 channels which can be used for input and output. By default P1.* are
output channels while PO.* are input channels.

P1.1 Available at J4 and reserved for a digital warning output (see chapter
3.2.5)

P1.2 Available at J4 and reserved for a digital alarm output (see chapter 3.2.5)

P0.2 Available at J4 and reserved for digital good output (see chapter 3.2.5)

P0.3 Available at J4 and reserved for digital invalid output (see chapter 3.2.5)

PO0.7 Available at J4 and can be used as external trigger to start the data
acquisition.

Note:

Up to software version 2010.0712 the active alarm and warning output were driven high. All later software
versions drive the active output low (/Invalid, /Good, /Warning, /Alarm).

USB driver LED

The LED next to the USB port at the rear panel indicates the status of the USB device. It will flash at a
frequency of 2Hz, if the DAQ2 module is properly detected by the PC (i.e., correctly enumerated, configured
and not suspended). A constantly on LED indicates that the USB device is not properly detected by the PC.
In this case see section 3.5 “Trouble Shooting”.

Power supply

The DAQ?2 is powered by the USB bus.

2.3 Accessories

Vallen offers the following accessories:

Item Description

ASCO-NTE Power supply (for 230V ONLY!)

CBL-2-1M5-V8 Cable D-Sub15pol. to 2*BNC for analyzing analog APK, ASL signals
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Item Description

CBL-2-1M5-V22 Special cable: 2 BNC to 15pole Sub-D (J4) at ASCO-DAQZ2; 1,5m long
(for feeding 2 additional parametric signals like pressure, temperature...)

CBL-4-2M-V25 USB cable 2m, type B / type A (for connecting ASCO-DAQ2 with PC).
Vallen AE sensors For an overview of available sensors see document reference [1]
MAGXY Magnetic holders for Vallen AE sensors (for details see document

reference [2]).
SIK Silicon adhesive couplant, 100g
SCA-SI Sensor coupling agent, silicon grease, 80 ml tube, -40°C to 180°C.

Feel free to ask Vallen sales (sales@vallen.de) for your specific needs.
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3 Operation Manual

3.1 Getting Started

This section describes the ASCO-DAQ2 hard- and software setup for performing AE measurements in 4
steps.

3.1.1 Step 1: ASCO-DAQZ2 software installation
The ASCO-DAQ?2 software consists of two separate items:
e acquisition and analysis software

e the National Instruments USB driver which is needed for the communication of the ASCO-DAQ2 with
the PC via the USB interface.

ASCO-DAQ? software comes on a USB FLASH DRIVE and can be found in the subdirectory: ascodag?2.

Copy the folder ascodaqg2 from USB FLASH DRIVE to c:\vallen (create this folder if it does not exist). This
installs ascodaqg2.exe, documentation, wave files and sample data.

After completing this step an offline analysis can already be done, i.e. opening and analyzing existing data
files.

For data acquisition the National Instrument driver needs to be installed.

3.1.2 Step 2: National Instruments driver installation

Before starting “setup.exe” make sure, that no other version of NI-DAQ driver is already installed; otherwise,
it must be de-installed. Start setup.exe of folder \NIDAQ* on CD (“*” is placeholder for most current release
identifier). Confirm all dialogues. No options need changes. At the end of the installation, the installer wants
to reboot the system. Please do so; otherwise, the USB device is not identified correctly

NI-DAQ driver software “remembers” the serial number of each USB-6009 ever attached and assigns a
unique name “Dev X" to each of them. ASCO-DAQ?2 software automatically identifies the currently attached
“Dev x” device.

Note: Only one ASCO-DAQ?2 unit can be operated by one PC at a time.

Note: In case the NIDAQ driver (NIDAQ922f0Core) is used with Win 7 32bit or 64bit operating systems there
may occur limitations when ASCO-DAQ?2 is connected via USB-hub or port replicator to a laptop or PC. Data
acquisition may not start again and the error message “Onboard device memory overflow” appears. In such
a case make sure that the ASCO-DAQ?2 is directly connected to an USB port of the laptop or PC.

3.1.3 Step 3: Hardware Setup
1. Connect the power supply to the ASCO-DAQ?2.

2. Connect the USB port of the ASCO-DAQ2 (connector J5), to a USB port of the PC by using the supplied
USB cable. The operating system will search for a driver of the new USB device. This may take some
time and finally it will tell that a new USB device has been detected and is ready for usage. Once the
operating system recognizes the USB device the green LED on the ASCO-DAQ?2 starts flashing. A
flashing LED indicates that the USB device is ready for data transfer. A permanent on LED indicates that
the USB device has not been properly recognized.

3. Connect the Vallen Systeme AE-sensor via the BNC connector (labeled J2) to the ASCO-DAQ?2.

4. Mount the sensor to the object that shall be monitored. For hints on how to mount AE sensors please
see document reference [1].
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1. Browse to the folder C:\VallenN\ASCODAQ and start the ascodag.exe by double clicking on it.

3.1.4 Step 4: Starting the measurement

2. Inthe dialog “Welcome to Vallen ASCO-DAQZ2" choose the “default.xml” file and press the “Start
recording” button.

3. Confirm the message that the “Default.log” data file will be overwritten.
Note: This message is not shown when the ASCO-DAQ?2 is operated for the first time!

The measurement starts automatically showing the ASL and APK signal. It can be stopped by pushing the
Stop-button or <F10>.

Now the measurement setup can be changed using the Configuration dialog which is accessible via the
menu bar->Edit->Configuration.

3.2 Software Overview

3.2.1 Main window

&9 vallen ASCO-DAQ2 =] X
Fie Edit Recording Help A
S & Q00 O = 5 ..|.APK|.ISLA12.A13 B
100 -5
wlsinteell ff AL S ALAL YA AL S ALY,
EgU_‘u"u'arning Levell” |7 VA 7|7 L= 17V AVArSD .AVarad
70 f/ -35
60 ’ -3
50 /} -25
40 r -2
30- I ' -15
20 Minimum Level B
10 -04
0 -0
1 | 1 | | 1 | | 1 | 1 1 | 1 1 | 1 | | 1 |
01 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Time [s] C
=—APK [dB] =——ASL [dB] Al3 Al —
Warning D
File: c:'\wvallen\ascodaq\Data'\2010-04-06_Test2\data\00000014.log Configuration: Default.xml *modified™ ET
The main window consists of:
e menu bar (A)
e toolbar (B)
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e diagram plane (C)
e monitoring result line (D)

e status line (E).

The elements: menu bar, toolbar and status line are explained in detail in section 3.3.1. The diagram plane is
described in detail in section 3.2.1.1 below.

3.2.1.1 Diagram plane

The results of the analog input channels (APK, ASL, Al2 and Al3) are graphically displayed in a diagram.
APK and ASL refer to the peak signal and average signal respectively. Al2 and Al3 are parametric input
channels that can be used to record process parameters such as load, pressure, elongation, temperature
etc. APK and ASL refer to the left vertical axis, whereas Al2 and Al3 refer to the right vertical axis. Above the
diagram is the “Heading” area. A user defined header can be displayed there.

<Header of diagram=

| | | | | | | | | | | | |
100+ -5
PO
gn_ﬁ&-'ﬂrmL'E‘f'el///////////////////////_515
E3[]_'\;‘u.-'arning Level -4
70+ -35
60— -3
50— -25
40+ -2
30+ -1.5
a _1
Minimum Level
10- -05
0- -0
| | | | | | | | | | | | | | | | | | | | |
0o 1 2 3 4 & 6 7 8 9 10 1M 12 13 14 15 16 17 18 19 20
Time [s]
—APK [dB] —=—ASL [dB] Elongation [pm] Pressure [MPa] ==
=Footer of diagram:
Warning

Below the diagram is the legend, depicting the graph style and its label as well as unit. Below the legend is
the “Footer” area. User defined footer can be displayed there.

Only if “Monitoring” (see section 3.2.5, “Process monitoring with ASCO-DAQZ2") is enabled, the monitoring
limits for each enabled channel are displayed in addition and monitoring results (Warning, Alarm) are
displayed below the footer area.

3.2.2 Operating modes

There are two basic operating modes called “Direct data recording” and “Post processed data recording”.

Direct data recording

The measurement data will be stored without any further post processing or evaluation.
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Only one data file will be created, and each subsequent measurement overwrites the data of the preceding
one. Therefore, the operator must back up the data file for each individual measurement if this is required.

This mode is useful if data files need not be archived (e.g., online process control performed by a worker).

For direct data recording uncheck the “Enable post processing” checkbox in the “Data” tab of the
configuration setting dialog (see chapter 3.3.3.4 Data Settings).

Post processed data recording

This mode automatically performs actions after the measurement has been stopped. The following actions
are provided:

e Archiving measurement data: data of each measurement is stored into a separate data file (previous
measurement files are not overwritten).

e Creating and storing screen shots of the diagram plane
e Generating a report file

This mode is useful if measurement data, screenshots of diagrams or reports shall be archived separately for
each individual measurement (e.g. data of each crimped item are archived for quality management
purposes).

To distinguish the different files a counter value is assigned to each measurement. This is done automatically
in Voltage Controlled Mode or manually before each measurement. The counter value is used as filename
for screenshots, measurement data and reports.

Warning: The counter is not checked for uniqueness; a wrong initialization value may overwrite already
existing files!

For post processed data recording check the “Enable post processing” checkbox in the “Data” tab of the
configuration settings dialog (see section 3.3.3.4, “Data Settings”).

Both measurement modes can be triggered manually (i.e., by pushing the record button of the toolbar) or by
a voltage applied to channel Al2 or Al3. The second way of triggering a measurement is called “Voltage
Controlled Mode”, VCM (see section 3.2.4.1, “Voltage Controlled Mode (VCM)").

3.2.3 Generated files and file storage

3.2.3.1 Measurement data file

Measurement data is stored in <xml> plain text to files with “.log” extension. In single file recording mode the
standard filename is “Default.log”. A different data file can be specified via the menu bar->File>New
Acquisition File ... (see section 3.2.3.6 “Changing the storage location”). However, after restarting the ASCO-
DAQ?2 software the data output file is “Default.log” again.

In post processed data recording mode there are two possibilities:
e “Archive recording data” is disabled: measurement data will be written to file “Default.log”

e “Archive recording data” is enabled: data files will be written to the “Data” subfolder on the path
specified by the user. The filename is headed by the counter value.

3.2.3.2 Reportfile

A report file is only generated if the “Enable post processing” checkbox has been enabled (menu
bar->Edit-> Configuration... > Data tab; see section 3.3.3.4, “Data Settings”) i.e. post processed data
recording mode is active.
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The report file contains the results of each measurement per line, called report line. The user may specify the
results which are stored by using macros. Macros are containers for the results of the measurement. A
complete list of macros can be found in section 3.3.4 “List of Macros”.

The report line is defined in menu bar->Edit-> Configuration...>Data tab: ,Report line field” (see section
3.3.3.4 “Data Settings”) and may contain macros as well as strings.

3.2.3.3 Screenshot file

The screenshot of the diagram of one measurement after the end of data recording is generated only if the
“Enable post processing” checkbox has been checked (menu bar—>Edit->Configuration... > Data tab; see
section 3.3.3.4, “Data Settings”) i.e. post processed data recording mode is active and if “Create PNG
images” is enabled (menu bar-> Edit-> Configuration... >Data tab; see section 3.3.3.4 ,Data Settings”).

3.2.3.4 Configuration file

Configuration files contain the selected configuration parameters (menu bar->Edit->Configuration). To create
a new configuration file first open an existing configuration file. Apply the intended changes to the
configuration and store the edited configuration as new configuration file (menu bar->File> Save
configuration as...).

3.2.3.5 Storage location of files

Data — and configuration files are stored by default to predefined directories.

Recorded data files

e Direct data recording mode: “c:\vallen\ascodag\data” by default

e Post processed data recording mode: c:\vallen\ascodag\data\<subfolder>\<data>
Report files

e c:\vallen\ascodag\data\<subfolder>. This folder contains the “report.txt” file which is the user defined
list of results of one specific measurement.

Screenshot files

e c:\vallen\ascodaq\data\<subfolder>\<images>

Configuration data files
e ‘“c:\vallen\ascodaq\configurations” by default.

<subfolder> is a placeholder for the “Configuration ID” which has to be set in “Data” tab of the Configuration
dialog (see section 3.3.3.4 “Data Settings”) and is used as name for the subfolder.

<data> and <images> are placeholders for the data and screenshot files. Their filenames are made up of the
Counter ID which identifies consecutive measurements.

3.2.3.6 Changing the storage location

The storage location of data files and configuration files can be changed via menu bar->File->Preferences...
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% Preferences

Folder preferences:
Use this dialog to change the default data root folder or configuration folder.

Data root folder:
C:\Wallen\ascodaq\Data

Configuration folder:

C:\Wallen\ascodaqg\Configurations
Defaults [ 0K ” Cancel l

Menu item Description

Data root folder The data root folder defines the folder to which data files are written.

Configuration folder The configuration folder defines the folder to which configuration data are
written.

Defaults This button restores the default settings again.

3.2.4 Trigger for recording
There are three possibilities to trigger the start of recording:
e manually by clicking the start button.

e by applying voltage to the analog input channels Al2 or AI3 (Voltage Controlled Mode (VCM)).
The applied voltage must exceed a predefined threshold.

e by using the digital trigger at pin14 of connector J4.

3.2.4.1 Voltage Controlled Mode (VCM)

VCM is enabled if either input channel, Al2 or Al3, is selected for VCM.

In VCM the trigger is defined by either of the analog input channels Al2 or Al3. The measured voltage is
compared to an upper threshold and a lower threshold. The recording starts if the input signal exceeds the
upper threshold and stops if it drops below the lower threshold. The recording will last at least for the
“Minimum recording time” once the measurement is started.

3.2.4.2 Digital Trigger

Data recording can also be started by setting the digital trigger at pin 14 of the connector J4.

3.2.5 Process monitoring with ASCO-DAQ2

Note: The following is a general description of process monitoring with ASCO-DAQ?2. For monitoring
crimping processes see section 0.

Monitoring

Throughout the following context monitoring means that one to four input signals AlO to Al3 (AIO is
predefined to APK and All is predefined to ASL; Al2 and Al3 are parametric channels) are compared
against individually defined limits and yield individual channel states. The states of up to 4 channels are
combined to yield an overall classification result (at the end of a measurement).
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Channel states

Each channel has a state based on the comparison of its signal with the predefined channel state condition.
A channel state condition is defined by a level and a minimum time the signal has to exceed the level.
Possible channel states are:

e Invalid = signal has not exceeded valid level for predefined minimum time.
e Valid = signal exceeded valid level for predefined minimum time.

e Warning = signal exceeded warning level for predefined minimum time.

e Alarm = signal exceeded alarm level for predefined minimum time.

For a better understanding of the following section all possible channel states are illustrated below.

11 1 1 1 1 11 ] 1 1 | I | ] ]
RN ; RN ; ool ] ; ol T T A,
|Alarm Level |Alarm Level |Alarm Level |Alarm Level ,'
ST 1] ; ST ; ST ; ST N I ¢
\Warning Level \Warning Level \Warning Level \Warnin el
60 1 60 1 60 — 1 60 1
50 0 50 0 50 0 50 0
40 -1 40 -1 40 o 1 40 -1
30 -2 30 -2 30 2 30 -2
20 - -3 20 - -3 20 - -3 203 -3
10 ﬁf i r" 4 10 \Valid Levej 4 10 ‘Id ‘Le‘vel‘ 4 10 \‘T_ ‘vel‘ 4
0 i -5 ot -5 0 -5 0 ———— -5
012345678910 012345678910 012345678910 0123456738910
Invalid Valid Warning Alarm
Monitoring conditions
Four monitoring conditions are defined:
e Invalid
° Valid
e Warning
e Alarm
Trigger requirement for monitoring conditions
Each of the monitoring conditions can combine the individual channel states in two ways to derive a
monitoring condition:
¢ all selected channels must fulfill a monitoring condition to yield the according result e.g. all channel
states must be Warning to yield a “Warning” result.
e only one channel must fulfill a monitoring condition to yield the according result, e.g. only one
channel state needs to be Alarm to yield an “Alarm” result.
Results of monitoring conditions
o if the Valid condition is fulfilled the result will be “valid” otherwise it will be “invalid”.
¢ if the Warning condition is fulfilled the result will be “warning” otherwise it will be “no warning”.
e If the Alarm condition is fulfilled the result will be “alarm” otherwise it will be “no alarm”
Each of the results has a priority assigned to it the following way.
1. *“no alarm” and “no warning” have priority O
2. ‘“invalid” has priority 1
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3. “valid” has priority 2
4. *“warning” has priority 3
5. *“alarm” has priority 4

Online monitoring states

The online monitoring state supports the operator during the measurement, i.e., to provide indication that
something is going wrong.

Two monitoring states are displayed online:
e Warning: if the monitoring condition Warning is fulfilled but not the Alarm condition and

e Alarm: if the monitoring condition Alarm is fulfilled.
In addition, acoustical output signals can be configured separately for each of the online monitoring states
and different electrical outputs are provided.
Measurement classifications

The measurement classification is designed to support the operator to evaluate the success of the applied
process. After finishing a measurement, it is classified into one of four classes: Invalid, Good, Warning or
Alarm.

The classification is based on the results of the monitoring conditions by applying the following classification
rules:

e Rule 1 — Priority Rule
The result with the highest priority is used for classification.

e Rule 2 — Mapping Rule:
An “alarm” result is mapped to Alarm.
A “warning” result is mapped to Warning.
A “valid” result is mapped to Good.
An “invalid” result is mapped to Invalid.

Based on these two rules the following situations may occur (this is not a complete list):

e During the measurement no online monitoring state has been triggered: classification can be Good if
the valid condition has been fulfilled or Invalid otherwise.

e During measurement the online monitoring state Warning is triggered, then Alarm: the measurement
is classified Alarm.

e During a measurement individual (but not all) channel states are “warning” or “alarm”. The
appropriate online monitoring state will not be triggered if the combination of channel states is set to
“all channels”.

The next table displays the possible channel states in the first major column called Channel States. The
channel state is indicated for each channel number 1, 2, 3 or 4. Each row resembles a potential
measurement result. The following major column summarizes the way the monitoring conditions (valid,
warning or alarm) combine the channel state results listed in the same row. The column Class lists the result
of the classification for each row. Finally, an explanation of why the classification yielded what result can be
found in the column Comment.
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Channel States Combination of Class Comment

can be channel states

Invalid, Valid, Warning and Combination can be:

Alarm One channel, All channels
or it has no influence (n/i)

Channel numbers monitoring conditions
1 2 3 4 | valid | Warn. | Alarm
I I I I n/i n/i n/i Invalid
\Y, \Y, \Y, \Y n/i n/i n/i Good
W | W | W | W n/i n/i n/i Warning
A A A A n/i n/i n/i Alarm
| (V, W, A)l All All All Invalid Possible online monitoring states are not triggered because all
channels are needed to trigger it. Instead, the result “I” leads
to a result “Invalid”
vV, W, A)l All All All Good At the end of the measurement, the valid condition is fulfilled
for all channels (all are above valid level).
\Y (1, V, W, A? One | All All Good
wW (|' V, W, A)l nli One All Waming At least one channel state is “warning” and not all channel
states are “alarm”. Therefore, classification is Warning since
warning result have higher priority than results from the Valid
condition
A (I, vV, W, A)l n/i n/i One Alarm

! parenthesis “()” indicate that any of the channel states can occur, no matter how often.

3.3 Complete Reference to ASCO-DAQ2 Software

3.3.1 Starting the Software

The software can be started in recording- or data replay mode. In recording mode data can be acquired. In
data replay mode previously acquired data can be replayed for analysis purposes. The first step after starting
the software is to decide whether ASCO-DAQ?2 software shall be used in replay- or recording mode.

3.3.1.1 Data recording

For data recording the operator must select a configuration file, which initializes the ASCO-DAQ2. A default
configuration is provided by Vallen Systeme.
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Welcome to Vallen ASCO-DAQ2 ﬁ

Getting started:

| ? User Manual ASCO-DAQ2 ]

Select mode of operation:

m Data replay

Select configuration:

File
= Default.xml
= VV_111.xml
= VW_11Aml
= IVW_ATAxmI
= DW_AAAm
= Test.xml
= VIW_1A8.xml

= vwA_1AAxml  cwallen\ascodag\Configurations),
= VWA _Ass.xml cwallen\ascodaghConfigurations),

Folder

c:'wallen\ascodaq\Configurations),
c:\wallen\ascodaq\Configurations),
c:'wallen\ascodaq\Configurations,
c:\wallen\ascodaq\Configurations),
c:'wallen\ascodaq\Configurations,
c:\wallen\ascodaq\Configurations),
c:'wallen\ascodaq\Configurations,

[. Start recording ” = Open

Getting Started

The buttons of this box link to documents, which are helpful for reference and for developing an ASCO-

DAQ2 application.

Select Configuration

In this group all available configurations are listed. Configuration files are automatically stored to the folder
c:\vallen\ascodag\configurations and all available files will be shown. To start the recording mode a
configuration file has to be chosen (selected file is highlighted).

The default.xml is provided by Vallen and can be used for a quick start of the ASCO-DAQ2. It must be used
as initial set-up in order to change configuration settings which are then stored as a new configuration file.
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3.3.1.2 Data replay

Welcome to Vallen ASCO-DAQ2

Getting started:

| ? User Manual ASCO-DAQ2

Select mode of operation:

Data recording | Data replay

Select data file for replay:

File

2) Other File
Crimp-Setup.log
gfkl8st-105-01-good.log
gfk18st-105-02-bad.log
gfk18st-105-03bad.log
gfk18st-105-04good.log
gfk38alu-080-01-good.log
gfk38alu-080-02-good.log
gfk38alu-090-01-good.log
gfk38alu-090-02-good.log
Kopie von gfk18st-105-01-good.log

[ o

Folder

Click here to browse...

c:\wallen\ascodag\SampleData,
c:'wallen\ascodaq\SampleData',
ci\wallen\ascodag\SampleData,
c:'wallen\ascodaq\SampleData',
ci\wallen\ascodag\SampleData,
c:'wallen\ascodaq\SampleData',
ci\wallen\ascodag\SampleData,
c:'wallen\ascodaq\SampleData',
ci\wallen\ascodag\SampleData,
c:'wallen\ascodaq\SampleData',

R, R | U [P PR, e SRR (PO U

(=]

In data replay mode data files are analyzed offline. To choose a data file for offline analysis double click a file

in the list or browse the file system by selecting the top entry “Other File”. When selecting a data file, the
according configuration is also loaded. While the configuration can be changed during off line analysis, the

changes are not stored to the initial configuration file.

3.3.2 Elements of the main window

3.3.2.1 Menu Bar

File Edit Recordng Help

The menu bar presents a File, Edit, Recording and Help menu. For a description of the menu items see the

sections below.
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3.3.2.2 File Menu
Fle Edit Recording Help

O New acquisition file... Ctrl+N

& Open for replay... Ctrl+0

& save data as...

& save configuration as...

Preferences... Ctri+R

& Print... F2

E 1 c:\valen\ascodaq\..\Crimp-Setup.log

E] 2 c:\vallen\..\..\gfk18st-105-01-good.log

E] 3 c:\vallen\..\..\gfk18st-105-02-bad.log

E] 4 c:\vallen\..\..\gfk18st-105-03bad.log

E] 5 c:\vallen\..\..\gfk18st-105-04good.log

Close

Menu item Description

New acquisition file... Creates a new acquisition file by opening the “Save File” dialog where a hame
for the new acquisition file can be specified.

Open for replay... Opens a file for replay by opening an “Open File” dialog where a recorded
measurement file can be opened for replay. The selected file will open with the
configuration settings that were used when it was recorded.

Save data as... Saves the current measurement data to file.

Save configuration as... Saves a configuration file that has been changed by opening a “Save File”
dialog where a name for the new configuration file can be specified.

Preferences... Opens a dialog where a path and folder can be specified to which files
generated in auto rearm mode are saved.

Print... Opens the “Print” dialog.

Close Exits the software.

3.3.2.3 Edit Menu

Fie = Edit Recording Help
% Configuration...

Menu item Description

Configuration... Opens the configuration settings dialog.

3.3.2.4 Recording
File Edit Recording Help
@ start F9

Select configuration...

Disable display
v Auto panning
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Menu item Description

Start Starts a recording.

In data replay mode (see section 3.3.1, Starting the Software) a dialog will open
to select a configuration file before recording starts.

Stop Stops the recording

Select configuration... Selects a configuration file for recording by opening the “Select Configuration”
dialog.

Disable display Disables the diagram display.

If data post processing is enabled (see section 3.2.2, Operating modes) and
archiving of diagram screenshots is enabled, screenshots will be saved to the
specified directory (see section 3.2.3.6, Changing the storage location) also the
diagram will not be displayed!

Auto panning Toggles auto panning.

3.3.2.5 Help

File Edit Recording Help
B User Manual ASCO-DAQ2
i About

Menu item Description

User Manual ASCO-DAQ2 Open the ASCO-DAQ2 user manual
3.3.2.6 Tool bar

The toolbar presents quick link buttons to various functions regarding file management, setup, display and
recording.

Symbol Description

e Opens the file open dialogue for selecting a measurement file for display and analysis

=) Opens the print dialogue for printing diagrams

% Opens the settings dialogue

O Jumps to the beginning of the recording. Use this function in cases time axis scaling does not
accommodate the entire plot to jump to the beginning of the measurement.

Q Scrolls backwards

Q Scrolls forward

Q Jumps to the end of the recording. Use this function in cases when time axis scaling does not
accommodate the whole plot to jump to the end of the measurement.

@), Zooms in
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Symbol Description

G Zooms out

» Starts recording in recording mode. In display mode a dialogue will open for selecting a setup
file before recording can start

| Stops recording

APK Toggles the APK (peak amplitude) graph

asL Toggles the ASL (slow average) graph

az Toggles the Al2 (analog input 2) graph

a3 Toggles the Al3 (analog input 3) graph

3.3.2.7 Status bar

File: c:\wvallen\ascodag\Data\Default.log Configuration: Default.xml  Status: Acquisition finished.

Item Description

File File to which data are recorded. Data in this file will be overwritten

Configuration Configuration file which is in usage for recording

Status Status of the acquisition software
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3.3.3 Recording Setup
3.3.3.1 Acquisition Settings

Configuration in Acquisition Mode X

Acquisition  Voltage Controlled Mode Data  Monitoring Display Diagram Comment

General acquisition settings:
Sample Rate (per channel) [Hz]: 10000

—
(=

Recording time [s] (0 for infinite):

Analog input channels (differential):
[ am: APK [¥] AI2: Analog input 2 (e.g. Stress)
[~1ATL: ASL [ AI3: Analog input 3 (e.g. Strain)
Output channels:

AQO0: Analog Out 0 (Threshold, 0..5V) [V]:

AO1L: Analog Out 1 (34, 0..5V) [V]:

T

Digital trigger:

If checked, the acquisition will start when the APK signal crosses a defined threshold.
The thresheld is set by ADD (SW3 on) or any other external digital signal (SW3 off).
An external digital signal can be fed in at pin 14 of 14 (triggers on positive slope).

For threshold independent recording do not use digital trigger!

[Juse Digital Trigger (FFIO, F0.7)

Cancel

General Acquisition Settings

Sample Rate (per channel) [Hz]:

Applied sample rate to each input channel. Sample rate can be up to 40 kHz. A useful sample rate in case of
the ASCO-PH3 is 50Hz (because of the 50ms of peak stretching, the sample interval should be
approximately half of it).

Recording time [s] (O for infinite)

This sets the maximum recording time. If recording should be terminated by user only set this parameter to
0. This setting has no influence in case of the VCM or batch mode.

Analog Input Channels (differential)

Analog Input AlO: APK

The analog input channel 0 is hardwired to the APK signal of the ASCO module. The APK signal is the
converted peak amplitude of an AE-burst to a voltage pulse of 40mV/dB e amplitude and 50ms pulse width.
Check AIO if input channel should be available in diagram.
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Analog Input All: ASL

The analog input channel 1 is hardwired to the ASL signal of the ASCO module. The ASL signal represents
the average of the logarithm of the AE signal over a certain time window and is an indicator for background
noise. Check Al1 if input should be available in diagram.

Analog Input Al2: e.g., stress

This analog input channel can be used to acquire an external process parameter which can be used to
correlate AE-data to process data. Check Al2 if input should be available in diagram and stored to HDD.

Analog Input Al3: e.g., strain

This analog input channel can be used to acquire an external process parameter which can be used to
correlate AE-data to process data. Check Al3 if input should be available in diagram and stored to HDD.

Output Channels

Analog out AOO

This output channel is internally connected to the analog threshold input of the ASCO unit. AOO can be used
to trigger the optocoupler output (connector J1, pin 3 and pin 10) if the APK signal (before peak stretcher)
exceeds the defined threshold. By default, this is set to 1.5V.

Analog out AO1

This output is available at pin 7 of connector J4 and is reserved for future usage. It can be set to a voltage (0
to 5V), the setting has no influence on the acquisition or the analysis software. By default, it is set to OV.

Digital Trigger

The digital trigger can be used to start the measurement by use of an external trigger. By default (factory
setting) the AOO is connected to the threshold comparator of the ASCO-P via the internal switch SW3 (set to
on). The measurement will start when the APK-signal exceeds the voltage setting of AOQ, i.e. the
measurement is triggered by a threshold crossing.

Alternatively, any other external digital trigger can be used to start the measurement. A digital trigger signal
can be fed in over pin 14 of J4 (see section 4.2.2.4 J4 — Parametric Input). In this case the recording is
started when the positive slope of the trigger signal is detected. To enable the external digital trigger the
SW3 switch must be set to off.

3.3.3.2 Remark on Sample Rate

The following figures show graphs which result of pencil lead breaks (short signal) recorded with an ASCO-
DAQ2-PH3 device with different sample rates.

Due to the peak stretching time of 50 ms for the APK, the peak amplitude is well recognized also for low
sample rates down to 50 Hz (sample interval 20 ms).

In the case of the ASL the sample rate influences the result when the AE burst is short in duration. The ASL
is calculated for a fixed number of samples. In case of slow sampling the number of low amplitudes, i.e.,
noise, samples dominate, while in case of faster sampling the samples with amplitudes higher than noise
dominate. One can see an effect of sample rates on the ASL in the graphs below. At sample rates of 1 kHz
and above, the difference in ASL becomes very small.

For longer burst signals the described averaging effect for the ASL will be smaller also for lower sample
rates.
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Figure 7: Signal of pencil lead break recorded with
sample rate 50 Hz
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Figure 8: Signal of pencil lead break recorded with
sample rate 100 Hz
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Figure 9: Signal of pencil lead break recorded with
sample rate 1000 Hz
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Figure 10: Signal of pencil lead break recorded with
sample rate10000 Hz
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3.3.3.3 Voltage Controlled Mode (VCM)

The VCM is used to start and stop the recording depending on the external parameter of the selected input
channel: Al2 or Al3. The start criterion is triggered if the signal of the selected channel exceeds a predefined
level. The measurement is stopped if the signal drops below a predefined second level.

Cenfiguration in Acquisition Mode x

Acquisition Voltage Controlled Mode Dpata  Monitoring Display Diagram Comment

Voltage Controlled Mode (WCM):

Use the Voltage Controlled Mode (WCM) to start and stop the recording depending on either
input AI2 or AI3. These inputs must be enabled on tab "Acquistion”.

The external input is checked against an upper and lower limit to control the recording. Limits
are given in display units (see tab "Display"). When started, the recording continues for the
minimum recording time specified, before the stop recording value is checked.

Check auto rearm in combination with Data post processing.

VCM Settings:

Use Vaoltage Controlled Mode on external input: A2 w
Start recording, when external input exceeds the value of: 1

Stop recording, when external input drops below: 0,5

Minimum recording time [s]:

I

Auto rearm

VCM Settings

Use Voltage Controlled Mode on external input

Select which external parameter (either Al2 or Al3) should be used to trigger the measurement. Only the
external parameter channels can be used to trigger the measurement.

Start recording when external input exceeds the value of

The recording will start if the external parameter of the selected input channel exceeds the defined limit. The
limit is given in units defined by the parametric conversion selected within the “Display”-tab.

Stop recording when the external input drops below:

The recording will stop if the external parameter of the selected input channel falls below the defined limit.
The limit is given in units defined by the parametric conversion within the “Display”-tab.

Minimum recording time [s]

The recording lasts at least as long as specified with this parameter. The unit is seconds.
After starting the recording continues till the minimum recording time is reached. Then the minimum
recording time will be checked for termination.
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Auto rearm

Check this box to enable the batch mode. The batch mode is suitable for processing (e.g., crimping) a whole
batch. Data for each individual process are displayed in a diagram and stored to HDD.

3.3.3.4 Data Settings

Configuration in Acquisition Mode *

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment

Result data handling:

Use data post processing to save data or PNG image of last recording in separate files.
Especially useful with Voltage Controlled Mode and "auto rearm” enabled.

The Configuration ID specifies a target folder for the data to be saved into. Root folder can
be changed in File / Preferences.

Data post processing:
[“]Enable past processing

Configuration ID: 20151116-1550 |

Measurement result identification

[*] Ask for object 1D Number of measurements per object:

[] Archive recording data. Note: Amout of data can be huge!
Folder: c:\vallen\ascodaq2\Data\20151116-1550\datal,

[ Create PNG images |[image size...) v|
Folder: c:\vallen\ascodaq2\Data\20151116-1550\images,

Report file: c:\vallen\ascodag2\Data\20151116-1550\report. bt

Report line: M | ID_=[0ObjectID]_=[RearmCtr];=[Date];=[Time];=[APK_Max];=

[APK_Lvlalm];=[ASL_Max];=[ASL_Lvlalm];=[AIZ_Max];=

[AI3_Max];=[ResultMonitoring]

Data post processing

Enable post processing

Check this box to enable the data post processing. Data post processing summaries the actions which are
performed after the recording has stopped. These actions can be archiving measurement data and/or
creating screenshots of the diagram and/or writing data to a report file.

Configuration ID

Configuration ID is an identifier of the measurement configuration. This name will be used to create a folder
to which data is stored during post processing.

Ask for object ID

Check this box if the program shall ask for an object ID before a measurement run starts. The object ID is
used as file name for storing measurement data. Data will be overwritten after confirming a warning dialog, if
a file exists with the identical object ID as filename.

Number of measurements per object

Enter the number of measurements per measurement run (see “Ask for object ID”). The specified number of
measurements will be done before the program asks for an object ID again. E.g. in case of crimping two end

file: ASCO-DAQ2_UMan_2307.docx 31

Copyright © 2023, Vallen Systeme GmbH



fittings onto an insulator rods: if the object is identified by the serial number of a rod, then two measurements
shall be done per measurement run / measurement object.

Archive recording data

Check this box to archive the measurement data. If checked a measurement file will be stored to hard disk
for each recording. Since measurement data are stored in plain text xml format these files can become very
large if the measurement time is long.

Create PNG images

Check this box to generate a png file of the diagram when the measurement has terminated. The image size
can be specified by using the right pull down bar.

Report file

In data post processing mode a report file will be generated automatically. The report file contains user
specified data of each measurement (see section Report line below).

The result of each measurement process is written to a separate line.

Report line
In this field macros and user text can be entered. Based on the selected macros, selected data and text will
be written in a line to the report file for each measurement.

For the detailed list of macros see: 3.3.4

3.3.3.5 Monitoring

Configuration in Acquisition Mode *

Acquisition Voltage Controlled Mode Data  Monitering  Display Diagram Comment

Monitoring conditions:
In monitering mode 1 to 4 inputs are compared to valid, warning and alarm conditions.
A condition can be fulfilled by at least one monitoring channel or by all channels.

Valid condition triggered by: One channel  ~

Warning condition triggered by: One channel  ~

Alarm condition triggered by:

Maonitor Valid condition ~ Warning condition  Alarm condition
Chan Enabled Level MinTime  Level MinTime Level MinTime[s]
ATI0: APK [dB] 5 0 70 0 85 0
AT1: ASL [dB] 5 0 70 0 85 0
load [kN] 5 0 70 0 85 0
strain 5 i 70 0 85 0
Monitoring status messages:
Monitoring Text: |M0nit0r |
Invalid Text: |Irwa|i|:| |
Good Text: |G00d |
Warning Text: |Warning |
Alarm Text: |Alarm |
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Monitoring Conditions

Valid condition triggered by:

Defines whether the valid condition is triggered by just one channel or by all channels.

Note: the valid condition is evaluated at the end of the measurement.

Warning condition triggered by: / Alarm condition triggered by:
These settings specify whether the warning / alarm condition is triggered by just one channel or by all

channels.

The settings for valid-, warning- and alarm conditions are governed in a table. Clicking in a cell of this table
selects and highlights it for editing.

Menu Item

Description

Enabled

Valid condition level

Valid condition MinTime

Warning condition level

Warning condition
MinTime

Alarm condition level

Alarm condition MinTime

check to use the channel for monitoring purposes

The level which the signal of the channel has to exceed to fulfill the valid
condition. The unit of this parameter is given in the parametric conversion settings
in the “Display”-tab.

The valid condition is checked at the end of the measurement only if a warning or
alarm has not been triggered. Only if the minimum condition is fulfilled the
measurement result will be classified as “Good”.

The minimum time specifies the minimum time period the signal has to exceed
the limit in order to fulfill the condition.

The level which the signal of the channel has to exceed in order to trigger the
“Warning”. The unit of this parameter is given in the parametric conversion
settings in the “Display”-tab.

The minimum time specifies the minimum time period the signal has to exceed
the limit in order to fulfill the condition.

The level which the signal of the channel has to exceed in order to trigger the
“Alarm”. The unit of this parameter is given in the parametric conversion settings
in the “Display”-tab.

The minimum time specifies the minimum time period the signal has to exceed
the limit in order to fulfill the condition.

Monitoring Status Messages (all messages are user defined)

Monitoring Text

This text will be shown during a measurement.

Invalid Text

This text will be shown if the classification result is “Invalid”.

Good Text

This text will be shown if the classification result is “Good”.
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Warning Text
This text will be shown if the classification result is “Warning”

Alarm Text
This text will be shown if the classification result is “Alarm”

3.3.3.6 Display

Configuration in Acquisition Mode x

Acquisition Voltage Controlled Mode Data  Monitoring  Display  Diagram Comment

Display:

Select the channels to be shown in diagram. Use Offset and Factor to adjust display scaling.
The legend text is shown below the diagram.

The left and right vertical axis scaling is defined by min/max values.

The initial time axis scale is given by start time and interval.

Chan Visible Offset Factor Legend
ATD 0 25 AID: APK [dB]
ATL 0 25 ATl: ASL [dB]
ALZ 0 -1 load [kN]

A3 0 strain

Left vertical axis (APK, ASL): Right vertical axis (A2, AI3):

Minimum: El Minimum: D
Time axis:

Start time [s]: D Display interval [s]: 12

Auto panning in online mode, step size [% of display interval]: 95

[15how horizontal legend ("Time [s]")

Canesl

The “Display” settings tab controls:
e which input channels are shown in the diagram
e the parametric conversion of the input channels
e the limits (scaling) of the x- and y-axis of the main diagram

Input channels can be added to the diagram by checking the checkbox in the “Visible” column. The cells of
“Offset”, “Factor” and “Legend” column can be selected and highlighted for editing by clicking. “Factor”
defines the slope of the parametric conversion. “Offset” controls the shift parallel to the y-axis:

y(x) = (x — Offset) - Factor

y(x) is the converted parameter, x the input signal in Volt, “Offset” and “Factor” are user provided attributes.
The standard Factor and Offset setting is 0 and 25, respectively for APK and ASL. Please use the factor of
25 for AlO and Al1l to get the result of APK and ASL in units of dB e which is the commonly used logarithmic
unit used in acoustic emission testing.

Legend defines the labels that appear in the legend for the graphs.
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The APK and ASL signals are always correlated with the units of the left vertical axis. The signals Al2 and
Al3 are always correlated with the units of the right vertical axis.

Left vertical axis (APK, ASL) / Right vertical axis (Al2, Al3)

Minimum / Maximum
These values define the minimum / maximum of the left / right vertical axis.

Time axis

The physical attribute of the horizontal axis is always the time and the time axis settings controls the
attributes of the horizontal axis.

Start time [s]:
This value defines the minimum of the horizontal axis.

Display interval [s]
This value defines the maximum of the horizontal axis.

Auto panning in online mode, step size [% of display interval]

Auto panning is automatically enabled if a “step size” greater 0% has been selected.
When auto panning is enabled the values of the x-axis are automatically shifted to the left when the
measurement time has reached the limit of the “Display interval”.

Example:  Start time = 1s; display interval = 10s; step size = 80%

In this case the x-axis will show 0s to 10s till the measurement time reaches 10s. At 10s the
values are shifted by 80% (=8s) to the left and the x-axis will show: 8s to 18s. At 18s the x-axis
will show 16 s to 26s and so on.

Show horizontal legend (“ Time [s]”)
Check the box to display the legend of the x-axis, uncheck the box to hide it.
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3.3.3.7 Diagram Comment

Configuration in Acquisition Mode X

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment
Caption:

M [visible

|<Enter caption here and check visible to show>

Comment:

EE=E= M [visible

<Enter comment here and check visible to show>

Caption

The caption appears as heading in the diagram and in the bitmap that is stored to hard disk drive. The
caption can be made up of alphanumeric strings and macros. Crimping results are made available by
macros. For the detailed list of macros see: 3.3.4

visible: check to make the caption visible in the diagram. If unchecked no caption will be displayed in the
diagram.

M: button shows a list of available macros (see section 3.3.4).
Comment

The comment appears as footer within the diagram and may be part of the documentation if “Post
processing” has been enabled and “Create PNG images” has been selected. The comment can be made up
of alphanumeric strings and macros. Crimping results are made available by macros.

visible: check to make the comment visible in the diagram. If unchecked no comment will be displayed in the
diagram.

M: button shows a list of available macros (see section 3.3.4).
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Macros are used to display interactive results. The can be inserted either in the Caption or Comment (see
3.3.3.7 Diagram Comment) or in the report line (see 3.3.3.4 Data Settings).

Macro Name

Description

=[Date]

=[LongDate]

=[Time]
=[LongTime]
=[ConfigID]

=[ObjectID]

=[RearmCtr]

=[ResultMonitoring]
=[FileNameConfig]
=[APK_LvIMin]
=[APK_LvIWTrn]
=[APK_LVIAIm]

=[APK_TimeLvIMin]

=[APK_TimeLvIWrn]

=[APK_TimeLvIAIm]

=[APK_Max]

=[ASL_LvIMin]
=[ASL_LvIWrn]
=[ASL_LvIAIm]

=[ASL_TimeLvIMin]

=[ASL_TimeLvIWrn]

=[ASL_TimeLvIAlm]

Current date: day, month and year are given in numbers. Output is according to
operating system format options.

Current date: name of the day, numeral of the day, name of the month and year.
Output is according to operating system format options.

Current time in hours and minutes (hh:mm)
Current time in hours, minutes and seconds (hh:mm:ss)

Identifier for the configuration. The identifier is chosen during the setup of the
configuration file. It is only available in VCM auto rearm mode.

Identifier for the measurement object. The identifier is entered before a
measurement run. It is only available in VCM auto rearm mode.

Rearm counter: counter for the number of batch processes. It is only available in
VCM auto rearm mode.

Container for the monitoring result of the process.
Container for the configuration file name that is used.
Current setting for the minimum level of APK
Current setting for the warning level of APK

Current setting for the alarm level of APK

Current setting for the time period the APK signal has to be above the minimum
level to fulfil the minimum condition.

Current setting for the time period the APK signal has to be above the warning
level to fulfil the warning condition.

Current setting for the time period the APK signal has to be above the alarm
level to fulfil the alarm condition.

Container for the maximum APK value during the monitored process.
Current setting for the minimum level of ASL

Current setting for the warning level of ASL

Current setting for the alarm level of ASL

Current setting for the time period the ASL signal has to be above the minimum
level to fulfil the minimum condition.

Current setting for the time period the ASL signal has to be above the warning
level to fulfil the warning condition.

Current setting for the time period the ASL signal has to be above the alarm
level to fulfil the alarm condition.
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Macro Name
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Description

=[ASL_Max]
=[Al2_LvIMin]
=[Al2_LvIWrn]
=[Al2_LvIAIm]
=[Al2_TimeLvIMin]

=[Al2_TimeLvIWrn]

=[Al2_TimeLVvIAIm]

=[Al2_Max]

=[AI3_LvIMin]
=[AI3_LvIWrn]
=[AI3_LvIAIm]

=[AI3_TimeLvIMin]

=[AI3_TimeLvIWrn]

=[AI3_TimeLvIAIm]

=[AI3_Max]

Container for the maximum ASL value during the monitored process.
Current setting for the minimum level of Al2

Current setting for the warning level of Al2

Current setting for the alarm level of Al2

Current setting for the time period the Al2 signal has to be above the minimum
level to fulfil the minimum condition.

Current setting for the time period the Al2 signal has to be above the warning
level to fulfil the warning condition.

Current setting for the time period the Al2 signal has to be above the alarm level
to fulfil the alarm condition.

Container for the maximum Al2 value during the monitored process.
Current setting for the minimum level of Al3

Current setting for the warning level of Al3

Current setting for the alarm level of Al3

Current setting for the time period the Al3 signal has to be above the minimum
level to fulfil the minimum condition.

Current setting for the time period the Al3 signal has to be above the warning
level to fulfil the warning condition.

Current setting for the time period the Al3 signal has to be above the alarm level
to fulfil the alarm condition.

Container for the maximum AI3 value during the monitored process.

3.3.5 Error Messages

Error number Description

1000 The NIDAQ driver is not properly installed. The NIDAQ driver is needed for the OS to
recognize the ASCO-DAQ?2. Please refer to the NIDAQ driver installation in section 3.1.2

1001 The ASCO-DAQ?2 unit is not connected to the PC. Check the USB cable for loose
connection.

1002 An unexpected error occurred during recording.

1004 An error occurred during reading of a data file. A line ended unexpectedly.

1005 An error occurred during reading a data file. An illegal character was found and could not

be converted.

1100 The selected pdf file has not been found in the given directory. Please
contact sales@vallen.de to get the document.

1101 An unknown pdf file has been selected. Please contact sales@vallen.de to get the
document.
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Error number Description

1200 No configuration files have been found in c:\vallen\ascodaq\configurations. Please store
your configuration files into this folder since the software requires at least one configuration
file in this folder.

Note: In case all configuration files have been deleted by mistake, the default.xml
configuration file must be copied from the Vallen ASCO-DAQ2 USB FLASH DRIVE.

1201 An unexpected error occurred when trying to save configuration file. Most probably the
folder or file is write protected and/or the current user does not have the permission to write
to the selected folder.

3.3.6 Paths
Important note: The ASCO-DAQ2 software has to be installed into C:\vallen\ascodaq!
See table below for a list of paths that are used by the ASCO-DAQ2 software.

Path Description

C:\vallen\ascodaq\ Root directory of the ASCO-DAQ?2 software installation.

C:\vallen\ascodaq\Configurations  Directory which contains the configuration files. At least one
configuration file has to be in this folder.

If no configuration file is in this folder a default configuration file is
generated automatically.

C:\vallen\ascodag\SampleData Directory which contains the sample data provided by Vallen.
C:\vallen\ascodaq\Docu Directory which contains the ASCO-DAQ2 documentation.
C:\vallen\ascodaq\Data Directory to which measurement data is written.
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3.3.7 Printing a page

Print dialog is available via menubar->File->Print...

% Printer Page Settings @

Orientation:

() Portrait

(@) Landscape

Units:

® mm

{_Jmil = 0.001 * inch

| L Position on Page:
Left [mm]:

Top [mm]:

Size on Page:
Width [mm]:

ke T T Height [mm]:
Eit on Page

o} st 21 22 W e 43 Lt e

[ e iEeam M E = e Gawwd e ]

[ Print... l [ Close
Page 1 of 1 Click on "Print" to continue or "Close" to quit.
Item Description
Orientation The print out orientation can either be Portrait or Landscape.
Units Select either mm or mil (milliinch). This setting will have influence if “Fit
on Page” is disabled.
Position on Page Defines the position of the print out with respect to the upper left corner.

This setting will only available if “Fit on Page” is disabled.

Size on Page Defines the size of the print out on the page. This setting will only
available if “Fit on Page” is disabled.

Fit on Page If checked the diagram is fitted on page (default). In this case “Position
on Page” and “Size on Page” settings have no influence.

3.3.8 File format of raw data file

The raw data file consists of two parts, an XML section and a data section. The XML section is separated
from the data section by the EOF (char 26, hex #1A). The XML section contains the settings while the data
section contains the measurement data.

The data section is pseudo-XML and headed by “[Setup]” section followed by a “[Data]” section. The ASCO-
DAQ?2 setup is briefly summarized in the “[Setup]” section. The measurement data is organized in a table
where the rows resemble the sample interval. The number of columns depends on the enabled channels.
The data is given in units of Volt.
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The following sample code is a shortened example of the data file:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<Vallen_XML>
<DocumentProperties>
<Title>ASCODAQ Setup</Title>
<Version>01.10</Version>
</DocumentProperties>
<ASCODAQ_Settings>
<Recording>

</Recording>
<VCM>

</VCM>
<Monitoring>

</Monitoring>
<Batch>

</Batch>
<Display>

</Display>
</ASCODAQ_Settings>
</Vallen_XML>

[Setup]

A00=1,500

A01=0,000

SamplingRate=10000
InitialAcquisitionDuration=1,0
ChannelTimeOffset=1/48000

StartTime: 06.04.2010 13:43:39
Enabled Channels: AlIO, All, Al2, AI3
Data layout:

AlO, All, AIl2, AI3

[/Setup]

[Data]

14478E-4 09868E-4 -00137E-4  -00013E-4
14478E-4 09868E-4 -00112E-4  00012E-4
[/Data]
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3.4 Using the ASCO-DAQ2 for monitoring crimp processes

3.4.1 Introduction

The ASCO-DAQ?2 can be used to monitor crimping process e.g., the crimping of end fittings to glass fiber
rods of high voltage insulators.

Figure 11: High Voltage
Insulator

Figure 12: Fitting on bare Figure 13: Joining a fitting and a fiber glass rod by a
fiber glass rod crimping process

To produce high voltage insulators (Figure 11) that shall carry heavy overhead power lines, a metallic fitting
is crimped onto a fiber glass rod (Figure 12). This crimping process (Figure 16) must be well adjusted. Most
important process parameters are hydraulic pressure and duration of pressurization. If the crimping pressure
is too low, the mechanical joint might fail under tension. If pressure is too high, the brittle fiber glass rod
might become damaged and fail under tension.
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Monitoring the acoustic emission during a crimping
process will detect any damaging of the fiber glass
rod in real time. The ASCO-DAQ?2 is the most
efficient solution for this application: simple to use,
highly accurate, and reasonably priced.

The ASCO-DAQ?2 software can be configured in the
way that a whole batch of insulators can be crimped
without making adjustments to the hard- or software.
A classification of the results can be done
automatically telling the operator whether the
crimping process was good, undefined or bad.

Figure 14: Example for sensor placement

The classification can be done depending on the conditioned AE-signal (APK or ASL) and up to two process
parameter (e.g. crimping pressure, etc.). For example, the measurement classification can be:

e ‘“Invalid” if the crimping process is considered invalid because e.g., minimum crimping pressure is
not reached.

e “Good” for insulators that have been crimped without damaging the fiber glass rod.
e “Bad” if the crimping process damaged the fiber glass rod.
e ‘“Undefined” if a clear classification cannot be made.

For this special production process Vallen provides the product “ASCO-Crimp” which consists of the
following components:

e AE-sensor (VS600-A2)

e Magnet holder for the AE-sensor (MAG4A1)

e Sensor cable (CBL-1-1M2-V15)

e ASCO-DAQ2-PH3, ASCO-DAQ?2 software, USB cable and ASCO-DAQ2 Operation Manual
e power supply (ASCO-NTE)

e CBL-2-2M5-V21, a special cable from ASCO-DAQ?2 to two external sensors e.g. pressure transducer
(2.5m, 15-pole SubD connector (male) on ASCO-DAQ?2 side, two free wires on transducer side, 4-
20mA, max. 5V)

e coupling agent for mounting the AE-sensor onto the crimp-jaws (HVF)

e Special sample data files for illustration

3.4.2 Setting up the data recording

The main objective is to configure the ASCO-DAQ?2 software in such a way that it is most suitable to be used
when crimping a batch of insulator rods. This includes setting up a suitable operation mode (see section
3.2.2 Operating modes) such as the “Post processed data recording mode” and a suitable recording trigger
(see section 3.2.4 Trigger for recording), such as VCM.

In most cases the data recording has to be monitored in order to classify the crimped insulator rods.
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The first step in setting up the data recording is to configure the recording trigger or VCM. Afterwards the
classification criteria, i.e., channel state conditions, have to be defined. Finally, the operation mode has to be
set.

3.4.3 Step 1: Starting and stopping the data recording in Voltage Controlled Mode
(VCM)

In VCM a voltage signal in channel Al2 or AI3 can be used to trigger the recording. Whether using a simple

electric switch or a pressure sensor, the trigger levels for start and stop of a measurement have to be set

correctly. In both cases it is recommended to make some trial runs to determine the trigger levels and to
prove correct function.

Connecting the external parametric input

Two external parametric inputs are available. A pressure sensor or electrical contact can be connected by
use of the two-wire cable “CBL-2-2M5-V21". This cable is part of the ASCO-Crimp-Package. For example,
the reference output of a pressure sensor (usually the negative pole) should be connected to the blue wire of
the CBL-2-2M5-V21and the positive pole of the pressure sensor with the brown wire. The voltage is
measured in differential-mode. The blue wire is grounded over 1kOhm via the ASCO-DAQ2. Connection of
external parametric inputs is a prerequisite step to use VCM.

To check the parametric input Al2 and Al3 must be activated by checking the “Visible” checkbox of Al2 and
Al3 on the “Display”-tab (see section 3.3.3.6 Display). Also, please make sure that the right vertical axis-
scaling is correct to show the measurement range.

Using a switch to control the recording

In this case a neutral electrical contact (e.g., a switch) can be used between the two wires of CBL-2-2M5-
V21. The input channel will observe a voltage of about 1.3V, when the contact is open and 0V, when the
contact is closed.

Using a pressure sensor to control the recording

The output of the pressure sensor can be transformed to physical units by setting “Factor” and “Offset” in the
“Display”-tab (see section 3.3.3.6 Display). Set “Offset” to the voltage of the pressure sensor at pressure=0.
For “Factor” the change of pressure per 1V is needed.

y[pyhsical units] = (u[V] - Offset[V]) - Factor[ 2 _unit]

By evaluating a test measurement, the start and stop level for the recording can be determined.

The start and stop levels for a measurement are set in the “Voltage Controlled Mode”-tab

(menubar—> Edit->Configuration...: Voltage Controlled Mode, VCM Settings group) in the fields “Start
recording, when the external input exceeds the value of:” and “Stop recording, when external input drops
below:” respectively. These values must be given in physical units according to the parametric conversion
defined.

Setup Example: using a switch

To start the recording by closing an electrical contact connected to Al2 (pins 1 and 2 of J4, see section
4.2.2.4 J4 — Parametric Input) the following settings apply to

e “Use Voltage Controlled Mode on external input:”: Al2,
e “Start recording, when the external input exceeds the value of”: 0.5V and

e “Stop recording, when external input drops below”: 0.5V

Afterwards make sure that Al2 is displayed in the diagram:
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e Inthe “Display” tab check the “Visible” checkbox of Al2.

e Make sure that the right vertical axis limits are set to -2V to +2V

Confirm the changes and start the data acquisition by a click on the record button of the tool bar (see section
3.3.2 Elements of the main window) or by pushing <F9>. Since VCM is enabled, the input channels are
scanned but data recording and display is not started as long as Al2 is below its start recording level. When
the contact is closed the recording starts and the measured signals are shown in the diagram. The
measurement ends if the contact is open again and the minimum recording time has been exceeded.

3.4.4 Step 2: Setting up monitoring

The ASCO-DAQ?2 Software can classify the results of a measurement according to the results of the
channels AIO, All, Al2 and Al3. This mode for classification is called “Monitoring Mode” (see sections 3.2.5
Process monitoring with ASCO-DAQ2, and 3.5.5 How to set up the monitoring of a channel).

AlO, also labeled APK, represents a signal that is proportional to the peak amplitude of the AE-signal in dBxg.
All, also labeled ASL, is a floating average of the logarithm of the rectified AE-signal, obtained by an 86Hz
low pass filter. While APK represents the peak amplitudes, ASL is more sensitive to the continuous signal
levels. Thus, it is sensitive to the background noise.

Single crack events in the specimen will be visible in APK. Steadily ongoing damage can be seen in a rise of
ASL.

Determination of the appropriate monitoring levels

Test measurements with good and bad crimping results must be carried out to define appropriate limits. For
this kind of test measurement, it is a good practice to disable VCM. Recording should be started and stopped
manually. Disabling VCM is done by selecting “None (disabled)” from the drop-down list in the VCM Settings
group of the Voltage Controlled Mode tab (see 3.3.3.3 Voltage Controlled Mode (VCM)).

The test measurements may yield results like the ones shown in the diagrams of Figure 15 to Figure 17.
Figure 15 shows an example of a good crimping process whereas Figure 16 shows the result of a bad
crimping process. Figure 17 shows the result of a reference measurement with a steel rod, where no
damage at all can be induced by crimping. The measured AE-signal shown in Figure 17 is related to the
background noise produced by crimping.

The brown curve shows the crimping pressure in bar in each diagram.
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110 110 110 7 - 110
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—AIO: APK [dB] —AI1: ASL [dB] Al2: Pressure — —AIO: APK[dB] —AI1: ASL [dB] Al2: Pressure —
Al3:unused Al3:unused
Figure 15: Good crimping example. Figure 16: Rod that is damaged during crimping.
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Figure 17: Results from crimping on steel.

From these measurements the channel state levels for Valid, Warning and Alarm must be determined. By
combining the results of more than one channel very complex classification conditions can be utilized.

The channel state conditions are defined in the “Monitoring”-Tab (menu bar->Edit->Configuration...,
Monitoring tab). A valid, warning and alarm level can be defined for each input channel AlO, Al1, Al2 and
Al3. If more than one channel is used for classification, the channel states have to be combined in an
appropriate way to yield a classification results (see section 3.2.5 Process monitoring with ASCO-DAQ?2).

Additionally, a time limit can be defined after which the according channel state condition is fulfilled.

3.4.5 Step 3: Setting up the operation mode

The final step is setting up a suitable operation mode (see section 3.2.2 Operating modes and 3.3.3.4.Data
Settings). The recommended operation mode is “Post processed data recording”. This is set by checking the
“Enable post processing” checkbox on the “Data”-tab.

Check “Auto rearm” on the “Voltage Controlled Mode™-tab.

for an automatic rearm of the measurement, i.e., VCM is rearmed after each crimping process.

The configuration is saved by selecting menu bar->File-> Save configuration as... The configuration file is
stored to the “Configurations” folder by default.
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3.4.6 Screenshots of the configuration

Configuration

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment

Analog input channels (differential):

General acquisition settings: i
Sample Rate (per channel) [Hz]:
Recording time [s] (0 for infinite): ; mode (VCM)

If checked, the acquisition will start when the APK signal crosses a defined threshold.
The threshold is set by AO0 (SW3 on) or any other external digital signal (SW3 off).
An external digital signal can be fed in at pin 14 of 14 (triggers on positive slope).

For threshold independent recording do not use digital trigger!

[Juse Digital Trigger (PFIO, P0.7)

Minimum 50, if ASL is also used
for alarm level higher value up to

1000 can be reasonable
\

f No effect in voltage controlled

AIO and All1 normally selected,

[ A10: APK [ A12: Analog input 2 (e.g. Stress) Al2 and AI3 dependant on

M A1 AsL [JAI3: Analog input 3 (e.g. Strain) T\\ connected external signal like
Output channels: — RrEsse,

AOQO0: Analog Out 0 (Threshold, 0..5V) [V]: 5

AO1: Analog Out 1 (34, 0..5V) [V]: 0

Digital trigger:

— Normally not used

Figure 18: General Acquisition settings

Configuration X

Acquisition Voltage Controlled Mode Dpata  Monitoring Display Diagram Comment

Voltage Controlled Mode (VCM):

Use the Voltage Controlled Mode (VCM) to start and stop the recording depending on either
input AL2 or AI3. These inputs must be enabled on tab "Acquistion".

The external input is checked against an upper and lower limit to control the recording. Limits
are given in display units (see tab "Display"). When started, the recording continues for the
minimum recording time specified, before the stop recording value is checked.

Check auto rearm in combination with Data post processing.

[4] Auto rearm

Goree

VCM Settings:

Use Voltage Controlled Mode on external input: A2 ———
Start recording, when external input exceeds the value of: 12

Stop recording, when external input drops below: 1

Minimum recording time [s]: 5

//J Select channel where e.g. the
L——" pressure signal is connected.

= Set these numbers to values to

~.__start and stop the measurement.
Touch down of the clamp and
release of the clamp should be
not within the measurement.

Figure 19: settings for voltage-controlled mode
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Configuration X

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment //|f enabled you will be asked for an\
object ID. Here you might also use

a barcode reader. The number of
measurements can be set e.g. to 2

if the same object is crimped on

Result data handling:

Use data post processing to save data or PNG image of last recording in separate files.
Especially useful with Voltage Controlled Mode and "auto rearm" enabled.

The Configuration ID specifies a target folder for the data to be saved into. Root folder can the two ends.

be changed in File / Preferences. //’/ If not enabled a number is

Data post processing: / increased automatically with each
Enable post processing //-f—“""’/,kneasurement. /
Configuration ID: [Te 3 [

Measurement result identification
O Number of measurements per object: |2

[ Archive recording data. Note: Amout of data can be huge!
Folder: C:\ascodaq2\Data\Test19July23\data\ (image size...) |V| [
[¥] Create PNG images I(:‘mage size...) v I Bitmap settings:
Folder: C:\ascodaq2\Data\Test19July23\images\ Dimensions in mm v
Report...: C:\ascodaq2\Data\Test19July23\report.txt ] -
Resor‘t line: ! M =cER\earm::tr]:=[Dalt‘;];l[‘lf)ime];=[APK_Max];=[APK_LleIm];= = b
[ASL_Max]; =[ASL_LvlAIm];=[AI2_Max];=[AI3_Max];= Equivalents to 1890 x 1299 pixels.
[ResultMonitoring] Bitmap size: 2,3 MB

Current screen resolution: 96 dpi.

Image resolution (dpi): m
1

1,

Font scale factor:

el | | 1=

Figure 20: Settings of the data tab

Configuration X

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment

Monitoring conditions:
In monitoring mode 1 to 4 inputs are compared to valid, warning and alarm conditions.

A condition can be fulfilled by at least one monitoring channel or by all channels. /Many combinations Of\
Valid condition triggered by: One channel N critera are pOSSib'E to
Warning condition triggered by: One channel ~ d iStingU ishthe
Alarm condition triggered by: different results of a

Monitor Valid condition ~Warning condit... Alarm condition L measurement. The

Chan Enabled Level MinTime Level MinTime Level MinTime values are in the

AID: APK [dB] %] w0 70 0 85 0 responsibility of the

|AIl: ASL [dB] %] 5 0 50 0 60 0

}m; Load [N] O 5 0 70 0 85 0 operator and must be

LAEEnggation [pm] D 5 0 70 0 85 0 ] dete rmlned by
Monitoring status messages: . t
Monitoring Text: Monitor QXDE riments. /
Invalid Text: Invalid
Good Text: [Good
Warning Text: |Warning
Alarm Text: ‘Alarm

cancel
Figure 21: settings of the monitoring criteria.
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Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment

Display:
Select the channels to be shown in diagram. Use Offset and Factor to adjust display scalin
The legend text is shown below the diagram.

The left and right vertical axis scaling is defined by min/max values.
The initial time axis scale is given by start time and interval.

Left vertical axis (APK, ASL): Right vertical axis (A2, AI3):
Minimum: 0 Minimum: 0 ; <

Maximum: 100 Maximum: 300

Time axis:

Auto panning in online mode, step size [% of display interval]: 99
[A Show horizontal legend

o

| Chan Visible Offset Factor s
AlD B o e

Al M 0 i

AR 0 50 ALR: Load [N]

AR O 0 1 AI3: Elongation [pm]

/

it

Start time [s]: D Display interval [s]: 120 g:

-

=

Use these settings for AlO and All
Offset: 0

Factor: 25
//
o
e~

Adapt the numbers for Al2 to
convert measured voltage to a

g physical unit.

Adapt to the min/max of Al2 in

—~ physical units.

Set a bit higher than the max.
duration of one crimping.

Figure 22: Display settings to convert measured voltage to physical units and setting of the axis.

Configuration

Acquisition Voltage Controlled Mode Data  Monitoring Display Diagram Comment

1]
]

tanﬁng::[Conﬁg!D]. ObjID:=[ObjectID], FileCtr:=[RearmCtr] Result: =
[ResultMonitoring]

Comment:

EEEM [HAuisible

ConfigFile: =[FileNameConfig], APK-Max:=[APK_Max], ASL-Max:=[ASL_Max], Al2-Max: =
[AI2_Max] =[Date] =[Time]

Goncel

Figure 23: setting text for caption and comment.
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3.5 Frequently Asked Questions

3.5.1 How to create a configuration file?

The settings of a measurement are specified by a configuration file. At the beginning there is just the
Default.xml configuration file provided by Vallen. To add new ones, open the Default.xml file. Edit the
settings according to your measurement setup. If you are done save the configuration file via menu
bar->File->Save Configuration as...

Configuration files will be written to the folder c:\Vallen\ascodag\Configurations or to the folder specified in
the “Preferences settings” (see section 3.2.3.6, Changing the storage location).

3.5.2 How to protect a configuration file from being overwritten?

In industrial operations it might be desirable, that machine/process operators cannot change the
configuration files developed by the process engineers. Configuration files can be protected by setting their
write protect attribute: right click on the file, choose properties and check write protection. To make this an
effective protection an administrator must define an appropriate user group which is allowed to change
directory/file attributes.

3.5.3 How to set up the Voltage Controlled Mode (VCM)?

In VCM mode a voltage applied to one of the analog inputs Al2 or AI3 controls the recording. Recording will
automatically start if the voltage in the selected input channel exceeds a defined upper threshold. The
recording stops automatically if the voltage in the selected input channel drops below a defined lower
threshold.

To setup the VCM mode one need to know:
e which analog channel shall be used to control the recording
e what shall be the upper threshold (start recording)
e what shall be the lower threshold (stop recording).

This data (especially the upper — and lower threshold) is obtained in trial runs of the measurement setup. For
trial runs it is favorable to disable the VCM and data post processing and to display all input channels.

To disable VCM go to menu bar->Edit-> Configuration...>Voltage Controlled Mode: Use voltage-controlled
mode on external input: select “None”.

To disable data post processing go to menu bar->Edit->Configuration...>Data: uncheck “Enable post
processing”.

To display all input channels, go to menu bar-> Edit-> Configuration...>Acquisition: in the group “Analog
input channels (differential)” check all channels AIO to Al3. Then go to “Display” tab and enable all channels
for display. In the “Display” tab one can adjust the axis limits for the measurement.

Once the upper — and lower thresholds are known VCM can be enabled. To do so go to menu
bar-> Edit-> Configuration...>Voltage Controlled Mode:

e Select the appropriate channel which controls the recording (Al2 or Al3). The same channel has to
be selected in the “Acquisition” tab, “Analog input channels (differential)” group. A message will be
prompted if the input channel is not selected in the “Acquisition” tab.

o Edit the field “Start recording, when external input exceeds the value of”. In this field enter the upper
threshold which governs when a recording starts.
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e Edit the field “Stop recording, when external input drops below”. In this field enter the lower threshold
which governs when a recording stops.

e Check the “Auto rearm” checkbox if VCM shall not terminate once a measurement stops. If checked
the software waits for a new trigger signal to start the recording.

The “Auto rearm” option is usually meaningful in conjunction with data post processing. Please refer to the
“How to setup multiple file recording” for instructions of how to set up the data post processing.

3.5.4 How to set up multiple file recording?
Multiple file recording is used when:
e measurement data shall not be overwritten;
e screenshots of the diagrams shall be saved to hard disk;
e areport file shall be generated.

Multiple file recording makes especially sense if VCM and “auto rearm” are enabled (please see 3.5.3 for
more information). Multiple file recording is set up in the “Data”-tab of the Configuration dialog
(menubar->Edit-> Configuration...>Data tab):

e Check “Enable post processing”;

e Choose a “Configuration ID”. The configuration ID will be used to create a subfolder in the data root
path;

e Check “Archive recording data” if measurement data shall be saved.
e Check “Create PNG images” if screenshots of the diagrams shall be saved.

e Generate a “Report line” by using macros and string text. A complete list of macros can be obtained
by clicking the “M” button or by referring to section 3.3.4.

e Click OK to confirm the settings.

3.5.5 How to set up the monitoring of a channel?

Monitoring requires specifying the channel state conditions and the monitoring conditions. The channel state
conditions are defined for each channel individually and consist of limits for are valid, warning and alarm
level. Additionally, the signal must exceed the level for a certain time period (minimum time or MinTime) in
order to trigger the result of the level.

Finally, the monitoring conditions combines the results of the channels to yield a classification result which
can be “Invalid”, “Good”, “Warning” or “Alarm”.

Therefore, the operator has the possibility for each channel to define three individual limits (valid, warning
and alarm) and a minimum period for each level.

To monitor an input channel, click the “Enabled” checkbox in the “Monitoring”-tab of the configuration
settings dialog (menubar->Edit->Configuration...>Monitoring). Then edit the minimum level -, minimum level
MinTime, warning level, warning level MinTime, alarm level and alarm level MinTime setting. The level
settings refer to converted units (for details see: 3.5.6).

To disable a monitoring channel, uncheck the “Enabled” checkbox.

If more than one channel shall be used for monitoring, it must be specified if just one channel must fulfill the
monitoring conditions or if all monitoring channels must fulfill them.
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The classification result will be displayed at the bottom of the diagram. The message that is displayed can be

" u ” oo

edited by the operator via the “monitoring text”, “invalid text”, “good text”, “warning text” and “alarm text” input
fields.

Click the “OK” button to confirm the settings.

3.5.6 How to do a parametric conversion of the input channels?

Input channels Al2 and Al3 can be used to measure external parameters such as load, pressure, elongation,
etc. The signal that is recorded is the voltage of the according external sensor. The voltage signal is
proportional to the physical units of the measured parameter. The ASCO-DAQ?2 software provides the means
of a linear conversion from voltage to physical units such as stress, elongation, pressure, etc.

The linear conversion is controlled by an “Offset” and “Factor” parameter. The “Factor” parameter defines the
slope of the linear conversion. The “Offset” governs the shift of the conversion.

y(x) = (x — Offset) - Factor

Where y(X) is the converted parameter in physical units, x is the input signal in Volt, Offset and Factor are
user provided attributes.

Usually the “Offset” and “Factor” parameters are given in the data sheet of the external sensor.

3.5.7 How to set up the automatic generation of a report file / screenshots / data
files?

The ASCO-DAQ?2 software provides the possibility to automatically generate a report file and/or screenshots
of the diagram and/or save the data files. This procedure is generally called data post processing.

Data post processing can be enabled (and disabled) in the menu bar—>Edit—>Configuration...>Data tab. To
enable data post processing check the “Enable post processing” checkbox.

Please specify a Configuration ID which will be used as the root folder for the report file, the image — and
data folder. The root folder for the measurement is created on the path specified by the menu
bar->File>Preferences... settings.

Two more checkboxes let you specify whether the measurement data shall be stored (checkbox “Archive
recording data”) or PNG images shall be created (checkbox “Create PNG images”).

A report file is always created if data post processing is enabled. In the Report line field, you can specify
which results should be logged by using macros (for the detailed list of macros see: 3.3.4).

3.5.8 How to exchange the ASCO-Pxy module?

The ASCO-DAQ?2 consists of an ASCO-Pxy module and a data acquisition unit. The ASCO-Pxy modules can
be exchanged to cover a different frequency range.

Prerequisite

An exchange ASCO-Pxy module is needed. Disconnect the ASCO-DAQ2 from power (i.e. unplug the USB
and power supply) before starting. Make sure that you are properly grounded before opening the ASCO-
DAQ?2.

Remove top cover

Remove the 4 top screws. Afterwards remove the cover by lifting it up.
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There is a Bridge board connecting the ASCO-Pxy to the USB unit. The bridge board is secured by a screw.
Remove the screw and lift the bridge board. The USB driver LED is connected to the bridge board and needs
gentle handling in order not to break.

Remove Bridge board

Figure 24: ASCO-DAQ?2 with the top cover removed. The PCB on the left-hand side is the ASCO-Pxy. The
bridge board is the PCB with the red switch on it. Underneath lies the PCB of the USB DAQ unit.
Exchange ASCO-Pxy

To exchange the ASCO-Pxy module remove the last two screws which join the front plate to the housing.
Insert the new ASCO-Pxy module and screw it onto the housing.

Mount Bridge board

First fit in the LED and gently plug in the board into the according counter parts of the DAQ unit and ASCO-
Pxy module. Secure the Bridge board by use of the screw.

Mount top cover

Finally mount the top cover. Because of spigot and socket of the interface there is only one way the top
cover can be mounted. After fitting it in, secure the top cover by use of 4 screws.

3.5.9 How to change sound Output?

There is a sound output associated to each classification result. With each classification result the according
sound file is executed. Classification result can be invalid, good, warning or alarm (class3).

To change the sound output simply copy a wav-file to the ascodag2 folder and rename it to the according
class: invalid.wav, good.wav, warning.wav or alarm.wav.

If you do not want sound output move the wav files to a different directory.

3.6  Trouble Shooting

If you are experiencing troubles with the ASCO-DAQ?2 and its software, contact the Vallen support team via
e-mail (sales@vallen.de) or call 0049 8171 38391 0. Our office hours are 09:00 to 17:00 CET.
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4 Specification

4.1  Signal conditioner ASCO-Pxy

AE-Preamplifier integrated in ASCO-Pxy (sensor-connector)

vallen
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Item

Description

Input impedance

>10MOhm parallel 10pF

Measurement range

+100 mVpk = 100dBAE

Gain 20dB
Noise (Inp.50R) PN1: 24dBae
PHy: 34dB e
Freq. range [kHz] PN1: 90-290
PH3:240-710
PH5: 90-1300
Filter roll-off high-pass 24dB/Octave, low-pass 12dB/Octave
Characteristic Butterworth

Threshold-Input

40mV/dB e , Ri = 10kOhm

Filter output voltage

approx. 2Vep @ 100dB 5e

equals 0.2Vpp @ sensor

Filter output max. load 5mA

APK-Output: (Peak-Amplitude)

Item Description

Voltage 4,0V @ 100dB g, 200kHz

40mV/dBAE,<10mA

Rise time (-3dB):

PNy: 25us, PHy: 7us (sine burst excitation)

Peak-Stretching

51ms of last amplitude increase (ASCO-DAQ-PHS5:
0.5 ms)

Error

+1dB (40-95dB ae, PHx:45-100)

ASL-Output: (Average Signal Level)

ltem

Description

Voltage

40mV/dBAE <10mA

APK-ASL-Offset

PN1: 0/0.7dB @200/100kHz
PH3, PH5: 0.6/2.2@500/250kHz
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Iltem

Description

Smoothing low-pass

PNy, PHy: 86Hz 6dB/Octave

Error +1dB (35-95dB )
Reset Input

Item Description

2-5V or open Peak Stretching: normal
ov Peak Stretching: off

Opto-Output

Item Description
normal open (5V max)
activated at threshold-crossing

Pulse duration

52-62ms, no post-trigger

4.2 ASCO-DAQ2

4.2.1 Dimension and weight

160,0
135,0

25,0

J5 Ja
use -—% Param. Input
Vallen - Systeme GmbH VO”en
The Acoustic Emission Company SQSCGTTE
ASCO-DAQ2
AE Signal Cenditioner and Data Acquisition System
+o0-r-
Ji J2 J3
( E Analog Qut Sensor 7..15V-DC
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Item Description

Dimension (I x w x h) 164mm x 104mm x 39mm (housing)
Width of mounting plate: 130mm

Overall length (including connectors): 185mm

Weight: 6369

4.2.2 External Connectors

4.2.2.1 J1- Analog output (D-Sub, male)

Signal J1 J1 Signal
Power +(7-15V) 1 9 Power -
Internal Pull up 2.2k to +5V 2 10 Output Opto-
Output Opto+ 3 11 GND

Output APK 4 12 GND

Input Threshold 5 13 GND

Input Reset 6 14 GND
reserved 7 15 Output Filter
Output ASL 8

For more information see the ASCO-P manual.

4.2.2.2 J2 - Sensor connector

Item Description
Input impedance >10MOhm parallel 10pF
Meas.range: +100mVpk = 100dB e

4.2.2.3 J3 - Power supply for ASCO-P

Item Description
Voltage 7-15Vpc Low Noise!
Power consumption max. 100mA

Alternative power feed in | Pinl (+7-15V) and Pin 9 (Power -) of J1

Control internal to +5V

4.2.2.4 J4 —Parametric Input (D-Sub, female)

For a description of the signals associated to each pin see the according description of analog input
channels (Al2, Al3), analog output channels (AO1) as well as digital channels (P0.x and P1.x).

Signal J4 Ja Signal

Al2- (Stress param.) 1 9 P0.2: good out (/Good)
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Signal J4 Ja Signal

Al2+ (Stress param.) 2 10 P1.1: warning out (/Warning)*
AnaGND 3 11 5V/100mA from USB

Al3+ (Strain param.) 4 12 P1.2: alarm out (/Alarm)

Al3- (Strain param.) 5 13 reserved

P0.3: invalid out (/Invalid) 6 14 P0.7 (trigger in, PFI0)

AO1 (spare an. out.) 7 15 DigGND

AnaGND 8

4225 J5-USB port

Iltem

Description

USB Specification

USB 2.0 full speed

USB bus speed

12Mb/s

Power requirements

4.10 — 5.25Vpc: 80mA typical, 500mA max
USB suspend: 300uA typical, 500uA max

Connector

USB series B receptacle

4.2.3 Analog input channels

Item Description
Input type differential
Input resolution 14 bit
Maximum sampling rate 48kS/s
Input range 5V

Input impedance 144kO
Over voltage protection +35V

AIO APK [dBg]: stretched peak signal, internally connected. For a detailed
despriction see the ASCO-P manual

All ASL [dBg]: slow moving average signal, internally connected. For a detailed
despriction see the ASCO-P manual

Al2 Free to be used. Available at J4, pins 1 and 2

Al3 Free to be used. Available at J4, pins 4 and 5

! In R2010.0712 software version high state is active
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4.2.4 Analog output channels

Item

Description

Converter Type

Successive Approximation

Number of outputs

2 (AOO and AO1)

Output resolution 12 bit
Maximum update rate 150Hz
Output range 5V
Output impedance 500
Output current drive 5mA
Slew rate 1Vius
Short circuit current 50mA

Absolute accuracy (no
load)

7mV typical, 36.4mV maximum

AOO

Internally connected to analog threshold input of the ASCO-P.

AO1

Externally available at J4, pin 7, can be set by software to a certain voltage.

4.2.5 Digital channels

Item

Description

Bidirectional channels

P0.0...P0.7, P1.0...P1.3

Output driver type

open drain

Pull-up resistor

4.7kQ to 5V

External pull up >672Q for max 8.5mA drain current

Compatibility

TTL, LVTTL, CMOS

Absolute maximum
voltage range

-0.5 to 5.8V with respect to GND

P0.2 Good output at pin 9 of J4

P0.3 Invalid output at pin 6 of J4

P0.7 External trigger to start data acquisition. By default driven from ASCO-P module
(see 4.2.6 Internal switches, SW3) Available at pin 14 of J4

P1.1 Warning output at pin 10 of J4

P1.2 Alarm output at pin12 of J4
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The internal switches are only available if the top cover has been removed. For a description of how to
remove the top cover refer to section 3.5.8 How to exchange the ASCO-Pxy module? Please contact Vallen
support team (sales@vallen.de) if you are unsure of what to do.

426 Internal switches

Item Description

SW1 On: connect the threshold comparator output with Al3+. This switch setting is
only used for functional verification test. By default, SW1 is set to off.

SW2 On: connect minus-input of J9 with Al3-. This switch setting is only used for
functional verification test. By default, SW2 is set to off.

SW3 On: connect the trigger input P0.7 with the threshold output of the ASCO-P. By
default, SW3 is set to on.

SW4 On: connect +5V of ASCO-P with Al2-. This is only used for functional
verification test. By default, SW4 is set to off.

4.2.7 USB driver LED

The LED next to the USB port indicates the status of the USB device. It will flash at a frequency of 2Hz, if the
device is properly detected by the PC. The flashing LED indicates that the device is correctly enumerated,
configured and not suspended. A LED that is constantly on indicates that the USB device is not enumerated,
not configured or is suspended.

4.2.8 DAQ2 Power supply
The DAQ?2 is powered by the USB bus.

429 PCrequirements

Computer Requirements:
e Free USB 2 or USB 3controller
e OS: Microsoft Windows 10 or 11

5 References

1 Acoustic Emission Sensors and Preamplifiers, Specification and Description by Vallen Systeme GmbH
2 Accessories for Acoustic Emission systems by Vallen Systeme GmbH

These documents are available at https://www.vallen.de/quote-ref/.

6 Abbreviations

AE Acoustic Emission

Alx Analog input channel x; refers to the input channels of the DAQ unit of the ASCO-DAQ?2. There are
four input channels available (AIO to AI3). AlO and All are reserved for APK and ASL output of
ASCO.

AOx  Analog output channel x; refers to the output channels of the DAQ. Only AOQ is used and is
internally connected to the ASCO
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ASCO Acoustic Signal Conditioner. Converts the sensor signal into a peak signal (APK) and a slow average
signal (ASL)

ASCO-NTE power supply of ASCO

ASCO-Pxy abbreviation for one of the ASCO modules which can be ASCO-PN1, ASCO-PH3, ASCO-
PH5.

APK  output of ASCO; peak signal stretched for 50 ms

ASL  output of ASCO; amplitude of average signal
DAQ Data Acquisition. Used in context with ASCO as ASCO-DAQ2

SW3 abbreviation for internal switch, only accessible if the top cover of the ASCO-DAQ?2 unit is removed.

7 Warranty Conditions for ASCO-DAQ2

The warranty period is two years from the date of its delivery for ASCO-DAQ2 hardware and software. This
warranty does not cover the repair of any damage to the products generated by accident or improper
handling. For warranty conditions for consumables such as sensors and cables see our documents “AE
Sensor Overview” and “Accessories for AE Systems”.

We warrant that the goods as delivered will conform to the given specifications. We do not warrant that
software is totally free from errors (See the End User License Agreement hereafter). If notified during the
warranty period that the delivered ASCO-DAQ?2 system contains defects such that it does not conform to the
specifications, we will make it operate as specified by providing replacement parts or software updates as
determined by us, free of costs, and within a reasonable time. If transportation should become necessary,
the customer must provide the permits for export and re-import of replacement parts and bear the costs of
transportation.

Except as expressed before, we disclaim all other warranties.

The ASCO-DAQ? is especially designed to work with AE-sensors of Vallen Systeme GmbH. Using AE-
sensors which are not approved by Vallen Systeme will terminate the warranty.

8 Conformity UKCA (UK Conformity Assessed)

The ASCO-DAQ?2 device is UK Conformity Assessed (UKCA).
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9 Redemption and Disposal Information of Used Vallen
Equipment

Equipment labelled with the symbol shown left must be disposed separately from
unsorted municipal waste within the European Union.

Owners of old instruments request our agreement to return old electronic
equipment. The goods to be returned must be described unambiguously and
identified by serial and/or identification number. You can fill in our contact form
(https://www.vallen.de/contact/) or send us an email to sales@vallen.de.

Upon our approval owners may ship the goods free of costs to us.

We will dispose the goods according to the relevant laws and regulations on our
costs.

Goods returned without our approval will not be accepted and returned to the
owner on his account.

We explicitly point out that according to § 19a ElektroG3 you are responsible to
delete any personal data on the appliances considered for disposal.

More information can be found under www.vallen.de/products/services/.
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10 End User License Agreement

Last Updated: June 2022
1.1. IMPORTANT - READ CAREFULLY

This Vallen Systeme End-User License Agreement ("EULA") is a legal agreement between you (either an
individual or a single entity) and Vallen Systeme GmbH for the Vallen Systeme software product identified
above, which includes computer software and may include associated media, printed materials, and "online"
or electronic documentation ("SOFTWARE PRODUCT"). The SOFTWARE PRODUCT also includes any
updates and supplements to the original SOFTWARE PRODUCT provided to you by Vallen Systeme. Any
software provided along with the SOFTWARE PRODUCT that is associated with a separate end-user license
agreement is licensed to you under the terms of that license agreement. By installing, copying, downloading,
accessing, or otherwise using the SOFTWARE PRODUCT, you accept the terms of this EULA. If you do not
accept them, do not install or use the SOFTWARE PRODUCT;

1.2 SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1.2.1. Types of Licenses

The SOFTWARE PRODUCT license can be version limited or date limited. The version limited license allows
you to exercise the rights granted in this EULA for an indefinite time up to a certain software version of the
SOFTWARE PRODUCT. The time limited license allows you to exercise the rights granted in this EULA for a
limited period for all published versions of the SOFTWARE PRODUCT.

1.2.2. KeyFile

The license type, its rights and restrictions can be enforced by a KeyFile. The KeyFile Certificate is the
human readable form of the KeyFile.

1.3. GRANT OF LICENSE

For the duration of this agreement, this EULA grants you the following non-transferable, personal, non-
exclusive rights:

1.3.1. Data Acquisition and Data Analysis Software

You may install, activate, use, access, display, run, or otherwise interact with ("RUN") the SOFTWARE
PRODUCT, or any prior version, provided it is compatible to the Windows operating system, on devices of
information technology ("COMPUTER").

A SOFTWARE PRODUCT which license is enforced by a KeyFile may be limited to RUN on a specified
number of COMPUTERS.

1.3.2. Storage/Network Use

You may also store or install the SOFTWARE PRODUCT on a storage device, such as a network share,
used only to RUN the SOFTWARE PRODUCT on your other COMPUTERS over an internal network;
however, you must acquire and dedicate a license for each separate COMPUTER on which the SOFTWARE
PRODUCT is RUN from the storage device. A license for the SOFTWARE PRODUCT may not be shared or
used concurrently on different COMPUTERS.

1.3.3. Reservation of Rights

All rights, especially all publication, reproduction, processing, development, and exploitation rights, not
expressly granted are reserved by Vallen Systeme GmbH.

1.4. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
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You may not, reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, make copies of the
SOFTWARE PRODUCT, except for what is granted in this EULA or with the prior written consent of Vallen
Systeme, publish the SOFTWARE PROCUCT for others to copy; rent, lease or lend the SOFTWARE
PRODUCT except for what is granted in this EULA; work around any technical limitations in the SOFTWARE
PRODUCT except and only to the extent that such activity is expressly permitted by applicable law
notwithstanding this limitation.

1.4.1. Limitations on reverse engineering, de-compilation and disassembly

1.4.2. Separation of Components

The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated on
different devices.

1.4.3. Support Services

Vallen Systeme may provide you with support services related to the SOFTWARE PRODUCT ("Support
Services"). Use of Support Services is governed by the Vallen Systeme policies and programs described in
the user manual, in "online" documentation, and/or in other Vallen Systeme-provided materials. Any
supplemental software code provided to you as part of the Support Services is considered part of the
SOFTWARE PRODUCT and subject to the terms and conditions of this EULA. With respect to technical
information, you provide to Vallen Systeme as part of the Support Services, Vallen Systeme may use such
non-personal information for its business purposes, including product support and development. Any
personal data is handled according to the General Data Protection Regulation (EU) 2016/679 (GDPR) article
6(1).

1.4.4. Software Activation

Vallen Systeme may collect, use and transfer machine specific data during SOFTWARE PRODUCT
activation. Information collected will be machine specific and will be used for activation of the related
SOFTWARE PRODUCT and SOFTWARE PRODUCT license validation.

1.4.5. Benchmarks

Performance benchmarks are defined for the system without background programs running. In case that any
background programs or services, such as antivirus, screen saver, backup service or other similar tasks, are
installed, the user must expect a performance drop of the system.

1.4.6. Software Transfer

License transfer needs the written permission of Vallen Systeme.
1.4.7. Duration

This EULA runs for an indefinite period.

1.4.8. Termination

This EULA may be terminated in writing within a three months’ notice. Without prejudice to any other rights,
Vallen Systeme may terminate this EULA if you fail to comply with the terms and conditions of this EULA. In
such event, you must destroy all copies of the SOFTWARE PRODUCT and all its component parts.

Upon termination of this agreement, you are no longer entitled to use the SOFTWARE PRODUCT in any
form whatsoever and to obtain upgrades or Support Services.

1.5. UPGRADES

If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly licensed to use a product
identified by Vallen Systeme as being eligible for the upgrade in order to use the SOFTWARE PRODUCT. A
SOFTWARE PRODUCT labeled as an upgrade replaces and/or supplements (and may disable) the product
that formed the basis for your eligibility for the upgrade. You may use the resulting upgraded product only in
accordance with the terms of this EULA. If the SOFTWARE PRODUCT is an upgrade of a component of a
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package of software programs that you licensed as a single product, the SOFTWARE PRODUCT may be
used and transferred only as part of that single product package and may not be separated for use on more
than one COMPUTER.

1.6. COPYRIGHT / INTELLECTUAL PROPERTY RIGHTS

All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images,
photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE
PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT are owned
by Vallen Systeme. Vallen Systeme retains and reserves all rights, title and interests in the intellectual
property rights of the SOFTWARE PRODUCT. All title and intellectual property rights in and to the content
which may be accessed through use of the SOFTWARE PRODUCT is the property of the respective content
owner and may be protected by applicable copyright or other intellectual property laws and treaties. This
EULA grants you no rights to use such content. If this SOFTWARE PRODUCT contains documentation
which is provided only in electronic form, you may print one copy of such electronic documentation. You may
not copy and/or open to third parties the printed materials accompanying the SOFTWARE PRODUCT.

1.7. DAMAGES DUE TO VIOLATIONS OF THIS EULA

The licensee is liable for all damages resulting from a violation of this EULA, including violations of
intellectual property rights suffered by Vallen Systeme.

1.8. LIMITATION OF LIABILITY/ DISCLAIMER OF LIABILITY

Vallen Systeme GmbH is not liable for damages of any kind to the extent of applicable law, as far as such
damages are not due to an intentional or grossly negligent behavior of Vallen Systeme. In no event Vallen
Systeme shall be liable for lost profits, consequential, indirect or incidental damages (including, but not
limited to loss of use, loss of data or business interruption). The statutory period of limitation for the judicial
assertion of claims for damages shall be shortened to 2 years.

1.9. DATA PROTECTION

The data protection notice from Vallen Systeme with all information on data protection is made available to
you separately. Further information is also available at https://www.vallen.de/datenschutz/ At your request,
the data protection notice will be sent to you again by post or by E-Mail.

1.10. MISCELLANEOUS
a. Place of performance shall be the corporate seat of Vallen Systeme GmbH, in Wolfratshausen/Germany.

b. The exclusive place of jurisdiction for disputes resulting from or in relation to this EULA shall be Munich,
Germany. Vallen Systeme is also entitled to bring the matter before the court at the corporate seat of the
licensee. The governing law shall be the law of the Republic of Germany excluding the conflict of law rules
and the UN Convention on Contracts for the International Sales of Goods (CISG).

c. If any terms and/or clauses of this EULA are invalid or become invalid, the validity of all other terms and/or
agreements shall not be affected. Invalid or absent clauses shall be replaced by valid clauses which
constitute the economic intend of the parties.

d. Vallen Systeme reserves the right to change any of the terms and conditions contained in this EULA at
any time and in its sole discretion. When changes are made, Vallen Systeme will revise the “Last Updated”
date at the top of this EULA.

e. In Addition to this EULA, the General Terms and Conditions of Vallen Systeme, available at
https://www.vallen.de apply
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